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Chapter 1
| nstallation

This Chapter explains how to install the Hardware Key (dongle) and the Software for the
Power CG Plus. It also describes the type of system that you will need before you can run
the Power CG Plus.

System Requirements

Operating system:

The Power CG Plusis designed to run under Windows 95, Windows 98, and Windows
NT 4.0. You need one of these operating systems on your computer in order to run the
Power CG Plus.

Processor (CPU):
The Power CG Pluswill run only on a 486 or higher processor. A Pentium (or higher) is
strongly recommended.

RAM:
The Power CG Pluswill run with aslittle as 16 Mbytes of system RAM. However it will
run very slowly. You should have at least 32 Mbytes of RAM.

Hard Disk Space:

Y ou must have a minimum of 30 Mbytes of Hard Disk space to run the Power CG Plus.
If you intend to create many Background Graphics, or save alot of pages as graphic
images (ie BMP, TGA, etc), make sure that you have enough Hard Disk space available.
Saving pages in the Cayman Graphics Page (PAG) format doesn’t require large amounts
of disk space (approx. 2-4 Kbytes per page) unless logos or textures are added to the

pages.

Floppy Disk Drive:
If you intend to install the software from floppy disks, the system must have a floppy
drive capable of reading 1.44 Mbytes floppy disks.

CD-ROM:
If you intend to install the software from a CD-ROM , the system must have a CD-ROM
drive.



VGA Card:

The VGA Card must be set to either 16 bits per pixel (High Color), 24 bits per pixel
(True Color), or 32 bits per pixel (Alpha) mode. If you run your VGA card in High Color
mode, the color spreads may not appear smooth on your VGA monitor. Thiswill not
affect the quality of the Title Graphics that the Power CG produces. They should appear
very smooth in 24 or 32 bits per pixel mode. The Power CG Pluswill not run if the VGA
mode is set to 8 (or less) bits per pixel.

The VGA Card should be a PCI bus version. The system will run with an ISA VGA card,
but it will appear to be slow because of the time it takes the program to update the screen
whenever you make changes.

LPT Port:
The computer must have at least 1 LPT port to install the Hardware Key (Dongle).

Installing the Hardware Key

The Hardware Key (from now on called the Dongle) is installed on your computer’s LPT
(printer) port. Before you install the Dongle, you should turn off, both the computer, and
any printer that may be connected to the LPT port. Once you have turned off the power,
you can install the Dongle.

If you have a printer connected to the LPT port you must unplug the printer cable from
the back of the computer before proceeding. Don’t worry, we will connect the printer
back up when we are done.

Plug the Dongle into the LPT port with the screws pointing towards the computer. Fasten
the Dongle to the computer by screwing in the two screws that are on both sides of the
Dongle. Thiswill keep the Dongle from falling out. If you had a printer connected to
this port, plug the printer cable into the Dongle and fasten it.

Y ou can now turn the computer and the printer back on. Try to print something to make
sure that the printer still works. The dongle should not interfere with the operation of the
printer in any way.



Installing the Software

The Power CG Plus has a Setup program to help you setup the software to run on your
computer. Thefileson theinstall disks are compressed. The only way to make sure that
the files are uncompressed correctly isto use the Setup program. The software can be
installed from either floppy disks, a CD-Rom, or from your hard drive.

Windows must be running before you can install the Power CG Plus software.

Installing from floppy disks

Insert the disk labeled “Power CG Plusinstall disk 1” into the floppy disk drive and
Run the SETUP.EXE program. One way to do thisisto press the Start button on the
Task Bar then Select the Run option. Enter A:SETUP (or B:SETUP if your floppy disk
driveisdrive B) then pressthe OK button. The system will begin installing the software.

Follow the instructions on the screen until the software is completely installed. When the
software is installed, the computer will restart. After the computer is restarted Power CG
Plus will be ready to run.

A folder called “Power CG” should now be in the Programs menu . There may aso be
an Icon called Power CG Plus on your desktop.

Installing from a CD-ROM

Insert the Power CG Plus CD-ROM into the CD-ROM drive. If the Power CG Install
window does not automatically appear after afew seconds, run the“SETUP.EXE”
program from the CD-ROM. The system will begin installing the software.

Follow the instructions on the screen until the software is completely installed. When the
software is installed, the computer will restart. After the computer is restarted Power CG
Plus will then be ready to run.

A folder called “Power CG” should now be in the Programs menu . There may aso be
an Icon called Power CG Plus on your desktop.



Installing from atemporary directory on theHard drive

All of theinstall files must be in atemporary directory to install the software from the
hard drive. Thistemporary directory SHOULD NOT be named POWERCG. Run the
“SETUP.EXE” program from the temporary directory. The system will begin installing
the software.

Follow the instructions on the screen until the software is completely installed. When the
software is installed, the computer will restart. After the computer is restarted Power CG
Plus will then be ready to run.

A folder called “Power CG” should now be in the Programs menu . There may aso be
an icon called Power CG Plus on your desktop.

Checking the I nstallation

Run the Power CG Plus program to test the installation by opening the Power CG folder
and double clicking on the Power CG Plusicon, or by double clicking on the Power CG
Plus Icon on the Desktop screen. The Power CG Plus program windows should appear
after afew seconds.

The message “ The Security Deviceisnot installed” will appear if the Dongle is not
properly installed. If this happens, check to make sure the Dongleisinstalled correctly.
Try unplugging the printer from the Dongle to seeif the printer isinterfering with it.



Chapter 2
| ntroduction to Power CG Plus

The Power CG Plusis used to create title pages. Of course you knew that or you wouldn't
have purchased the program. The best part of Power CG Plusis how those titles can be
used. You can usethe ON AIR capabilities of the program to display the pages, you can
title over your existing graphics, or you can use the pages to title the video in your Video
Editing System.

The ON AIR capabilities of the Power CG Plus alows you to create alist of pages and
then display those pages either automatically or under manual control. Under manual
control each page that you have created can be displayed with its' assigned page
transition. Each page is displayed when you want it, for aslong as you want it. The
pages can be pre-loaded so that they are displayed instantly when you pressthe TAKE
button. A list of pages can also be set up to automatically sequence. Each page will be
displayed with its' selected Page Transition type, and will appear for its specified Dwell
Duration. The Pages will continue to be automatically displayed until you stop it. This
featureis very useful for creating Kiosks and Message Information Channels.

Y ou can title over your existing graphics by loading the graphic as a background image
and adding thetitle to it. Once thisis done, the titled graphic image can be saved back to
the disk in a standard graphics format.

To use Power CG Plus pages with your Video Editing System, the pages can be imported
directly into the time line using the plugin that is available for many of the popular video
editing systems, or they can be exported in aformat that your video editing system will
recognize.

The title pages can contain text (of course), background color boxes, geometric shapes,
full-color graphic images as logos, and either a background graphic or background video.

The text can be created using TrueType typefaces and can be sized, rotated, and italicized.
Each character can have up to two edges and three shadows. The character’s edges and
shadows can be colorized with either a solid color, a vertical color spread, a color
gradient (4pt , 5pt, or linear), or with atexture.

Background color boxes can be created any size and position on the screen. They can be
colorized with al of the same color options as the characters, they can even be made semi
transparent.



Geometric shapes can be created at any size and position on the screen.  The roundness of
the shape can be controlled. The shape can be made square, completely round (asacircle
or elipse), or anywhere in between. Shapes can be sized, rotated, italicized, edged, and
colorized just like any other character.

Standard graphic format graphics can be loaded as either full-color logos or asa
background image. When they are loaded as logos, they can be sized and positioned
anywhere on the screen.

Power CG Plus User Interface

If you don't have the Power CG Plus software installed yet, follow the directionsin
chapter 1.

Start the Power CG Plusjust like you would any other program under Windows. After a
few seconds the Power CG Plus Windows will appear. The software automatically
adjustsits’ windows to fit your screen. If your screen resolution is set to 800 by 600, it
will appear similar to figure 2-1. If your screen resolution is set to 1024 by 768, it will
appear similar to figure 2-2.
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Figure 2-1, Screen appearance on a 800 by 600 VGA screen.
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PLG Cayman Graphics' Power CG Plus - Untitled
File Edit Miew Attributes
Power CG Plus menu.

Move Text Lavers Settings OnAir Help

The menu (shown above) isjust what you expect in aWindows program. It hasaFile
entry that is used to open, create, and save, the types of files that Power CG Plus can
open, create, and save (pages, page lists, and projects). It has an Edit entry used for the
normal Undo, Cut, Copy, Paste, Insert, Delete, and Erase functions.

The View menu is used to display or hide the various windows. The Move Text menu
has commands for Word Wrap/UnWrap, Centering, Justifying, and Positioning. It aso
has a command to let you adjust the Row Leading.

The Attributes menu is used to adjust the various text attributes.

The Layers Menu is used to change the layering priority (move onein front of another).



The Settings menu is used to setup your system. These include things like Setting User
Preferences, Load Typefaces, Set Tabs, Adjust Safetitle Margins, set the page to
Lower Third mode, and setting your default folder S/directories.

If your model of Power CG Plusis capable of On Air Operations, it will have an On Air
menu. This menu allows you to place the program in Manua On Air, or Automatic
Sequencing mode.

The Help Menu isfor learning more about how to use the program.

TOOLBAR

=] &|elelo] ISelﬂded Text |
Power CG Plus Toolbar

| ¢l

The Toolbar (shown above) is a quick way to access common functions. These include
commands from the File menu such as Create New Page, Open Existing Page, and Save
page. Cut, copy, paste,and undo functions from the Edit menu are included on the
toolbar.

The toolbar contains a mode selection box that defaultsto "Selected Text". This
determines which text will be modified by a command such as select font. The options
include such things are Selected text, entire word, entire row, entire layer, and entire

page.

To the right of the mode selection box are some buttons that Center and Justify the
current layer. There are even buttons to change the priority of the current layer (move one
in front of another).



PROJECT MANAGER

liza

Project Manager.

The project manager (Shown above) is used to keep settings and pages from different
projects separate from one another. It also gives you quick accessto all of the pagesin the
project. The top of the Project Manager displays the name of the current project.

When aPageis saved, a"PICON" is created which is aminiature image of the page.
These PICONSs, aong with the name of each page in the project is displayed in the Project
Manager. To open a page, just click onits PICON.



TITLE COMPOSE WINDOW

The Title Compose window is where you compose your title pages. To enter text in this
window, point the mouse to where you want the text to appear, and click the left mouse
button. A rectangle appears where you clicked the mouse. Thisisthetext cursor. It
shows where text will be entered. Type some text and it will appear at the cursor
position.

SHORTCUT BUTTONS

The Shortcut Buttons window contains buttons of frequently used functions. They are
placed in this handy position so that you can just reach over and easily press one of these
buttons with the mouse.

PRESET STYLE GALLERY

Each project can have up to 64 preset text styles. These are text styles that will probably
be used frequently. You're not limited to only these 64 styles, they are only there as
shortcut to the styles that you use most often. Y ou can scroll through the preset text
styles, and select one by clicking onit. When you select a new style from the Style
Gallery, all selected text will be set to the new style. After the new preset text style has
been selected, any new text that you enter will appear in the selected text style. You can
change these preset text styles to be whatever you want.
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CONTROL TABS

The Power CG Plus gives you alot of control over the appearance of the characters. So
much so, that all of the controls required to set all of the different parameters that can be
controlled, would not fit on your screen at one time. So we have divided them up into
groups and placed each group of controls on its' own separate tabbed sheet. We then took
each sheet of controls and placed them all in a single window with atab to select which
group of controls that you want to use.

Character Tab

Logos Background - Image I Backaround - Colors | Fage Tranzitions I

Character | Edges I Shadows I Colars I Layers I Pozitioning I Row Spacing I Shapes
— Height Width Itailicz R otation F.erning — Blur : ;
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Tupeface ] O ]

IBasset Bold j Lol [z VT Enes Ml ove Mo Rotate

This tab lets you change the Height, Width, Italics angle, Rotation, Kerning, and Blur of
the character. It is also used to select the Typeface of the text. The text size, position,
italics angle, and rotation can also be changed by clicking and dragging the cursor
handles. Y ou can turn the handles on and off. So they only appear when you want to use
them.

Any of the values represented by icons (Height, Width, Italics, Rotation, Kerning, and

Blur) can be modified by clicking on the appropriate icon and dragging the mouse. The
text will be redrawn with the new values as you drag the mouse.
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Edges Tab

Logoz | Background - Image I Background - Colors I Page Tranzitions I
Character Edges | Shadows | Colarg | Layers I Fozitioning I Row Spacing | Shapes
—Edage 1 —Edge 2
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Each character can have 2 edges. Y ou can select from the following:

No Edge

This edge does not appear

Full Surround

The edge surrounds the character equally on all sides

Extruded

The character is extruded to give the character a 3D look

Hilighted

The character is extruded with anarrow full surround border to Hilight the character
Offset

The edge is offset asif it is casting a shadow.

The depth and blur of each edge can be set separately. If the selected edge type is either
Extruded, Hilighted, or Offset, the direction can be set to any of the 8 directions.

Both edge work identically. Edge 1 appearsin front of Edge 2.
Clicking on the "Depth™" icon and dragging the mouse will change the edge depth.

Clicking on the "Blur" icon and dragging the mouse will change the edge blur. The text
will be redrawn with the new values as you drag the mouse.
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Shadows Tab

Logoz I Background - Image I Background - Colors I Page Tranzitions
Character I Edges Shadows I Colors | Lapers I Positioning I Riow Spacing | Shapes
— Shadow 1 — Shadow 2 — Shadow 3
Shape — Offzet— Shape — Offzet— Shape — Offzet—
Mone || Character ﬂ Mone I I:haracterl Mone I I:haracterl

Edge 1 I Edgez | Yertical I Edge 1 ﬂl Yertical ﬁ" Edgez Yertical
Rk Al I Al K i
18 i 20 i I 2 i
Harizantal Harizantal Harizantal
I Al . Al . Al
14 i 20 i 26 i

Each character can have up to 3 shadows in addition to the 2 edges. The shape of each
shadow can be set to be the same as the shape of the Character, Edge 1, or Edge 2.

All 3 shadows work the same.

Each component of the character (Character, Edges, and Shadows) stack up in the
following order:

oSourwbdE

CHARACTER
SHADOW 1
EDGE 1
SHADOW 2
EDGE 2
SHADOW 3

Shadow 1 is between the Character and Edge 1, Shadow 2 is between Edge 1 and Edge 2,
and Shadow 3 is behind Edge 2.

The position of each shadow can be independantly varied in single pixel increments. They

can be offset from the character by as much as 100 pixelsin any direction. Clicking on

the "Offset" icon and dragging the mouse will move the shadow in relationship to the
charater.

The color of each shadow can be set independantly. It can be set to any color (including a
Gradient or a Texture) just like the characters and edges.
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Colors Tab

Logoz I Background - Image
Character I Edges I Shadows
Component -
HiEker
—= | Character - ¥ Top Color
o |
2 Shadow 1 Sliders
¥ Ao | [ Eattom Colaor
i Palette |
Shadow 2
Edge 2 Gradient |
e Fick Col
Shadow 3 Textures | fnlzucm Sgrzran

| Background - Colors I
Colors I Layers I Fozitioning I Row Spacing |

Page Tranzitions
Shapes

Trans:

I al
0 X
Yideo:

P

The Colorstab lets you change the color of the Character, both Edges, and all 3 Shadows.

On the left there is a group of boxes that display the current color of each component of
the character. The box below it shows the color of the current component.

To change the color, select the component to change (Character, Edge, or Shadow) then

use the controls on the right to select the color. There are five waysto select acolor. You
can use a color picker, color dliders, select a color from a preset palette, set the color to a
gradient, or set the color to atexture.

Select one of the 5 buttons to select which method you want to use to select the color.

Here are the different methods you can use to select colors, these are:

Color Picker
Color Sliders
Color Palette
Color Gradients
Texures
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Color Picker

Eicker
W Top Colar Trans:
Shiderz I
[~ Bottom Color ’ ;l
Palette
e Wideo:
Gradient ses e ID =
Pick Calar
Testures frarm Screen

The color picker lets you select a color using avisual approach. Y ou can set the top and
bottom colors separately. If the top and bottom colors are different, the Character, Edge,
or Shadow will be drawn with a smooth color spread between the top and bottom. One of
the controlsin this box is used to select the Hue (red, yellow, green, blue, etc) of the
color. When anew hueis selected the other color box will change to reflect the new hue.
Y ou can select any color from this box just by clicking the mouse on the desired color.

Y ou can also vary the Transparency and the amount of External video levelsthat the text
component will be drawn with. Transparency will let whatever is behind the component
to show through. Setting the Video Level draws the component with a mixture of
background video and a color. The higher the video level, the more dominant the
background video will appear.

The"lllegal Color Indicator” will appear red if the selected color isanillegal NTSC or
PAL color. It will appear green if alegal color is selected.

Sliders
Picker
—— 1 | Top Colar Hue '—J— |3|:":|
Sliders " RGE
¥ Bottam Colar Luma. J— IEI
F'a|EttE r;" HLS :
T Gat f ——— | i[19g
Gradient Legal Colr J I

] il )—— 0

The color sliders let you select the color using a numerical approach. Y ou can choose
whether you want to define RGB (red, green, blue) values or HLS (Hue, Luma,
Saturation) values. The top and bottom colors can be set separately. If the top and bottom
colors are different, the Character, Edge, or Shadow will be drawn with a smooth color
spread between them.

Testures | Trans.
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Y ou can also vary the Transparency and the amount of External video levelsthat the text
component will be drawn with. Transparency will let whatever is behind the component
show through. Setting the Video Level draws the component with a mixture of
background video and a color. The higher the video level, the more dominant the
background video will appear.

The"lllegal Color Indicator” will appear red if the selected color isanillegal NTSC or
PAL color. It will appear green if alegal color is selected.

Palette
Picker
[ Top Color
Shiderz
—— | [ Bottom Color
Falette

Temtures | Background Yideao

Drouble Click on any Colar button ta modify it

Y ou can select any of the 64 preset colors from the color Palette. The top and bottom
colors can be set separately. If the top and bottom colors are different, the Character,
Edge, or Shadow will be drawn with a smooth color spread between them.

The"lllegal Color Indicator” will appear red if the selected color isanillegal NTSC or
PAL color. It will appear green if alegal color is selected.

Y ou can also select Background Video as the color just by pressing the "Background
Video" button. To modify the color palette, double click on the entry that you want to
modify. The Color Palette Editor will appear. Thislets you change the color of each
palette entry.

16



Gradients

Picker

Shiderz

Palette

Ejf=[nl[=ixs

Textures

Double Click an anp Color Gradient to modify it

Each project in the Power CG can have as many as 64 preset color gradients defined.

They can be either linear gradients or area gradients. A Linear Gradient can have up to 16

color points and can be rotated up to 90 degreesin either direction. An area gradient can

set each corner to adifferent color and the colors will create a smooth blend between the

colors. A center color point can also be added to create a 5 point color gradient. The

center point can be positioned anywhere within the color gradient. Thisis very useful for

creating Hilited colors.

Y ou can modify acolor gradient by double clicking on the one you want to modify. The

Color Gradient Builder will then appear. The Color Gradient Builder can then be used to

select the type of gradient, aswell as the color and position of the pointsin the gradient.

Textures

Picker

l
I
I
o

l
l
il

Shiderz

Gradient

Palette

il

I
I

ﬂl

I
I
[

il

I
I

Il

Il

I

Il
Il
Il

—

lertires

Ll

Double Click on ar Testure to modify it

The Textures button lets you apply atexture to any of the text components (Character,
Edges, or Shadows). Select any of the loaded textures by clicking the mouse on the

desired texture. There can be up to 16 textures loaded for each page. Any GIF, TIF, TGA,
BMP, or PCX image can be used as atexture. To load a new texture, double click on the

position that you want to load it into then select the image that you want to load as the

new texture.
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Layers Tab

Logos I Background - Image I Background - Colors I Fage Tranzitiohs
Character I Edges I Shadows I Colars Lapers Faszitianing I Faw Spacing Shapes
? Move Layer Layering Order
Layer M amne: IBaCkQFDUHdS colors to Top Tabular Data
Template Data
b ove Laver .
Layer | Delete Layer I * Up 1 Layer _ arounds colors
. yJACEMOLNas Colais
@ Displayed | 1 'C e o NEW LAYER, J | oveLaver
" Hidden haold down the CTRL key Do 1 Laper
and click the mouse at the Move Layer
desired position. i to Battom

Power CG can place text on multiple layers. These layers are completely independant of
the other layers. Changing something on one layer will not effect the text on the other
layers. Each layer can be assigned a unique name. The "Layering Order" list

shows the current order of the layers. The Top layer in the list is the front layer of the
page. A layer isin front of all of the layersthat are listed below it in the layering list, and
behind all of the layers that are listed above it. Each layer can be moved in front of, or
behind other layers. Thisis done by using the buttons to move the layer to the top layer,
Up 1 Layer, Down 1 Layer, or to the bottom layer. The order of the layers can also be
changed by dragging it from its current position to the new position in the "Layering
Order" list.

Individual layers can be hidden so that they do not cover the lower layers that you are
working on.

To create anew layer, press and hold down the <Ctrl> key, then click the left mouse
button where you want the new layer to appear on the screen.
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Positioning Tab

Logos I Background - Image I Background - Colors I Fage Tranzitiohs

Character I Edges I Shadows I Colars I Layers Pasitioning | Faw Spacing | Shapes
Wword YWrapdUnwrap Fiow % Layer " Page Fine t
— = — — Pozitiohing ———
i T T ¥ |= ‘
- — | — — | — i ‘L v

- T e | e— e | e ')__ < — 7 Heset

& el | — — | — 4\. — Text

' Position

The Positioning tab has the buttons that are used to Wrap and Unwrap words, Centering,
and Justifying rows, entire layers, and entire pages. The text can also be fine positioned
by using "Fine Positioning™ buttons.

The text can also be positioned by dragging the Movement cursor handles with the
mouse.

Row Spacing Tab

Logos I Background - Image I Background - Colors | Fage Tranzitiohs
Character I Edges I Shadows I Colars I Layers I Faszitianing Fow Spacing I Shapes
Change Row Spacing of Less More
<« | | >
™ Entire Layer
" Entire Page Set Diefault Row Spacingl

These controls are used to change the row leading (spacing) of the cursor row, the entire
Layer, or the Entire page.
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Shapes Tab

Logos I Background - Image I Background - Colors I Fage Tranzitiohs |

Character I Edges I Shadows Colars I Layers I Faszitianing I Faw Spacing Shapes
Azpect Ratio Roundness————————————

Add

Faoreground

Shape
| — Thyt I 0%

Add ||.....I....| |.I..........

Background

Shape . 4 R ! 4 .

Shapes are boxes that you can control the roundness and aspect ratio of. Once a shape has
been placed on the page you can sizeit, colorize it, add edges and shadows to it, and even
rotate it. In fact you can do anything to a shape that you can a character (except change
its' typeface of course). A foreground shape gets inserted into the current layer at the
cursor position. A background shape gets added to a new layer that is behind the text that
is currently selected.

The aspect ratio of the shape can be changed from tall and skinny to very wide. The
roundness of the shape can be set to any value from 0 to 100%. A roundness of 0%
creates a shape that has square corners. A roundness of 100% creates a shape that is either
acircle or an elipse (depending on aspect ratio). A value between 1 and 99% creates a
box that has rounded corners. The amount that the corners are rounded is determined by
the roundness setting.

Logos Tab
Character | Edges I Shadows I Colars I Layerz I Pozitioning I Fiow Spacing Shapes
Logos I Background - Image | Background - Calars I Fage Tranzitions

Add Mew
Logo
Logo Mame:

b aximum Height: I B Scanlines ID:\powercgd\manual'&ﬁlugu. TGA

b amirnurn wfidtk: | 150 Pixels

Full color logos may be added to the page. As many as 16 different logos can be placed
on apage. The logos can be loaded directly from GIF, TIF, TGA, BMP, or PCX images.
If the selected logo image includes an apha channel, the apha channel is supported.
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When you Press the "Add New Logo" button, a window appears that allows you to select
the logo image that you want to place on the page. Once alogo is placed you can size it
just like you would a character.

Background - Image Tab

Character I Edges | Shadows | Colars Layerz I Pozitioning I Fiow Spacing Shapes
Logos Background - Image Background - Calars I Fage Tranzitions
— Background Graphic Pasition

(B aykZELanpdhﬁideu] Graphic - Onginal Size

Graphic - Full Screen Graphic - Tiled | | |

JD Apowercgdsmanual HOPE TOW M. brp

There are two types of backgrounds that can be added to the pages. A background
graphic, or background colors. A GIF, TIF, TGA, BMP, or PCX image can be loaded as a
background Graphic. If the background Graphic includes an alpha channel, the apha
channel is supported.

A background graphic can be displayed Full screen, Original Size, or Tiled. When a
background graphic is loaded as Full screen the graphic is scaled so that it appears full
screen. When a background graphic isloaded in itsoriginal size, it will not be scaled. A
set of buttons will appear to allow you to position the background graphic on the page.
Tiling a background graphic that is smaller than the screen will repeat the graphic
horizontally and vertically to fill up the entire page.

If you select the "No Graphic" button, no background graphic will appear. The
background video will be displayed as the background.

Background - Colors Tab

Character I Edges I Shadows I Colars | Layers | Pozitioning | Raow Spacing Shapes I
Logos I Eackground - Image Background - Calars Page Transitiohs
Meww B ackaround ? _—
Caolor Box ¥ Top Color Trans:
Full Screen * ID Al
Backaround Calar ¥ Battom Color x
Palette |
Delete Background * Yiden:
Color B ox Bl | I_D &l
Canvert Color Box i Pick Color x
to Shape Textures | from Screen
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Background color boxes can be added to the page. These are very much like the
background color boxes in version 3.1, except you have more options on how to color the
box. You can apply a solid color (with transparency and Background video) or you can
apply acolor gradient (linear, 4 point, or 5 point). Y ou can even apply atextureto a
background color box.

As many as 32 color boxes can be placed on each screen. The layering order of
background color boxes can be changed.

Page Transitions Tab

Character I Edges I Shadows I Colars I Layerz I Pozitioning I Fiow Spacing | Shapes |
Logos | Background - Image | Background - Calars Page Transitions
— Page Tranzition ilote Bl
Wipe from Tap to Bottom j ' Top " Irfrom Top & Baottom
Transition Duration |30 Frames Lot £ Right " Outto T':.'l:' & Battam
10-99391 I from Sides
Dowell Duration (150 Frames = Battom = Out to Sides

Some models of the Power CG have ON AIR capabilities so that you can use the Power
CG asan ON AlIR titler. When thisis available you can set certain parameters for the
Page Transitions. Y ou can set the Transition Type, Transition Speed (Duration) and the
Dwell Duration (for Automatic Page Sequencing).

The left side of thiswindow lets you select these settings. If a Page Transition type has
multiple options (such as wipe), the right size of the window has the controls for selecting
these options. If a Page Transition does not have multiple options (like a Cut), These
optional controls do not appear.

STATUS BAR

Ready | Laver: Main | Owenarite [Fows 1 Col: 1 5
The Status Bar (shown above) at the bottom of the screen displays the current status of
the program. It isdivided into 4 panes. The first pane displays aone line HINT about the
Toolbar button or Menu entry that the cursor is currently pointing to. The next pane
shows the name of the current layer. The third pane shows the current typing mode (insert
or overwrite). The last pane displays the current row and column position of the cursor
within the layer.

22



Chapter 3
Editing Text

The easiest way to learn how to use Power CG Plusisto useit. In this manual we will
create some pages. They may not always be pretty, but they will demonstrate how to do
the various functions that the Power CG Plus has to offer.

Create a New Project

Before we begin creating pages with the Power CG Plus, let’s create a new project for
the pages. Thisisdone by selecting the “New Project” command from the “File”
menu. When thisis done awindow like the one below will appear.

Create a New Project |

Mew Project Hame: |:|
Cancel |

Let’scall our project TUTORIAL. Enter the name of the new project where it says“New
Project Name” and pressthe “Create” button. The name of the new Project now
appears at the top of the project manager. Since we haven’t created any pages for the new
project yet, no pages appear in thelist. During thistutorial we will create pages for the
TUTORIAL project.

Create New Page

Create a new page by selecting the “New Page” command from the “File” menu. This
could also be done by pressing the first button on the Toolbar. If you have modified text
on the current page (and “ Always Ask First” is selected under “ Automatically Save
Pages’ in the “User Preferences’), awindow like the one below will appear.

Automatically 5ave Pages |

Do you want bo zave
the changes to the
current page?

Mo |

[F wou don't want the spstem to keep
azking pou thiz guestion, use the
"Uzer Preferences" command in the
"Setup’ menu to change the
“Butamatically Save Pages' settings.
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This reminds you to save any changes to the page before you create the new page. Once
you have selected “Yes” or “N0”, awarning message (shown below) will appear warning
you that the current page is about to be erased.

Mew Page |

@ Thiz will eraze the current page.

Are pou sure you want to do thiz?

If you pressthe “No” button the “New Page” command will be canceled. If you press the
“Yes’ button the page will be erased and you will be asked which type of page you would
like to create by a window like the one shown.

Select the Page Type

Select the type of page that you want to create.

Y ou can chose between 3 different types of pages, Still, Roll, and Crawl. Create a“Still”
page by pressing the “ Still” button. Thiswill create a new page that is blank.

Title Compose Window

The Title Compose window is where you compose your pages. This window displays the
title graphic that you are working on as you compose it. If thiswindow is smaller than
the actual title graphic that you are creating, the title graphic will be scaled to fit this
window. If thetitle graphicistoo small to see, try one of the followiing:

Maximize the Power CG Plus program.

Use a higher resolution VGA mode (ie 1024 by 768).

Use the View menu to turn off other Power CG Plus windows to make more room for
the Title Compose Window.

Select the View Title Full Size command from the View menu to make the title
compose window full size.
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Typing Text

To enter text in thiswindow, point the mouse to where you want the text to appear, and
press the left button. A rectangle appears where you clicked the mouse. Thisisthe text
cursor. It shows where text will be entered. Now type the message “| Really like the
Power CG Plus”, the text will appear on the VGA screen asyou typeit. If you are
running on a system that has a separate video output, you will notice that the text also
appears on that screen.

If the text istoo big to fit on the screen, select a smaller text style from the Style Gallery
(on theright side of the screen) and throw away the page with the Big characters by
creating a new page again. Then re-type the message “| Really like the Power CG”
with the smaller text style.

Moving the Cursor

Y ou can use the cursor movement keys to move the cursor around in this window, or you
can use the mouse to point to where you want the cursor to be placed and click the left
button. The Arrow keys move the cursor one character or row in the direction of the
arrow. The <Home> key moves the cursor to the beginning of the row if it’s not already
there. If the cursor is at the beginning of the row and you press the <Home> key, it will
move to the beginning of the layer. If the cursor isalready at the first character of the
layer, the<Home> key will move the cursor to the beginning of the “Main” layer. The
<End> key moves the cursor to the end of the row if it’'s not already there. If the cursor is
aready at the end of the row, it will move to the end of the layer. If the cursor is already
at the end of the layer, the <End> key will move the cursor to the end of the “Main”

layer.

Editing Text

Move the mouse over the “R” in “Really” and press down the left button on the mouse.
While holding down the Left button, drag the mouse to the “i” in “Like” and release the
mouse button. Notice how the cursor expands to cover the text “Really Li”. Thisisthe
text that is now selected. Any operations done to the text, will be done to the text that is
selected. Press the <Del> key. The text that was selected was deleted. To get this text
back, hold down the <Ctrl> key and press the <Z> key (you could also press the UNDO
button in the toolbar). The last operation (delete in this case) is undone. The Power CG
Pluswill let you UNDO as many as 1000 operations.

Move the cursor to the “P” in the word “Power”. Hold down the <Shift> key and press
the <Enter> key. This splits the row into two rows. A new row is created under the
current row and the character that the cursor ison, and all characters after it, are moved
down to the new row.

25



Press the <Enter> key to move the cursor to the beginning of the next row. Hold down
the <Shift> key and press the <Ins> key. Thisinserts anew row at the cursor position.
Now type“Cayman Graphics”. Let’'sdelete this new row. We could use the UNDO
function, but let’ s use the delete row function instead. Hold down the <Shift> key and
press the <Del> key. The cursor row is deleted and all rows underneath it move up to take
its place.

Move the cursor to the “R” in “Really”. Delete this word by holding down the <Ctrl> key
while pressing <Del>. The entire word is deleted and all text to the right of it moves
over to fill in the space. Move the cursor to the “i” in “like”. Type the letters “ove”. The
new |etters replace (overwrites) the text aready on the screen. Y ou can change the typing
mode (see the “Insert Mode” command in the “Settings” menu).

Move the cursor to the beginning of the second word on the top row. Insert five (5) spaces
by pressing the <Ins> key 5 times. Now type the characters“Just”. This enters a new
word in the space that you just inserted (4 characters for the word, 1 character for the

space).

The functions that you just learned (as well as others) can also be invoked by using the
commandsin the “ Edit” menu. This menu also shows the keyboard short cut keys for
these commands in case you forget them.

Saving the Page

Before we go through the “Erase Text” functions, let’s save the page so we can use it
later. Select the“Save Page” command from the “File” menu, or press the Third button
(with the floppy disk icon) in the Toolbar. Since this page has not yet been named, you
will be prompted to enter a name for it. Once the name has been entered (Let’s call it
FIRST) pressthe“Save” button and the page will be saved to the current project.

Notice that asmall “PICON” of the page appears in the Project Manager window along
with the name of the page.

Erasing Text

The “Edit” menu has commands for erasing text. Y ou can erase text from the cursor
position to the end of the row, from the cursor position to the end of the page, or al of the
text on the page.

Move the cursor to the “V” on the first row, then go to the “Erase Text” entry in the
“Edit” menu and select “to End of Row” command. Notice that all of the text from the
cursor position to the end of the row is erased.

Select the “to End of Page” command and al of the text from the cursor position to the

end of the page is erased. Select the “Entire Page” command, and all of the text on the
pageis erased.
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Backspace

If you make a mistake while typing (such as typing the wrong character) just press the
<Backspace> key. Thiswill move the cursor to the previous position and erase the
character there. If the system isin Insert mode, the character will be deleted. You can
then type the correct character.

Using Tabs

The Power CG allows you to set up to 16 tabs per page. These tabs specify horizontal
positions on the screen. Columnar text can be aligned to the tabs. If the Tab Display is
enabled, the tab positions appear as vertical lines the entire height of the screen.

The tabs behave differently depending on the typing mode. In the Insert mode, pressing
the <Tab> key will insert atab character at the cursor position. All text to the right of the
new tab will be moved to the next tab position. Pressing the <Tab> key in the Overwrite
typing mode will move the cursor to the character at the next tab position. If notab is set
to the right of the cursor, the cursor will move to the beginning of the next row.

The width of the Tab character is automatically adjusted so that the next character is
placed at the next tab position. If no tab is set to the right of the tab character, it is treated
the same as a space. Changing the text to the left of the tab character (by entering more
text or changing the size of the text) will not move the text that you have placed at the
next tab position unless the text becomes too big to fit in the allotted space.

Normal typing will not overwrite a Tab character (even in the Overwrite typing mode).
Any text that is entered before the tab will be inserted at the cursor position and the width
of the tab will be adjusted to keep the text at the next tab position from moving. To get
rid of a Tab character, use the <Backspace> or <Del> key.

The tab positions are stored with the page. When a page isrecalled from the disk, the tab
positions that the page was created with are loaded with it.

For more information on default set tabs, setting tabs, deleting tabs, and tab display see
the section titled “ Setting Up Tabs” in chapter 12.

Row Space Allocation

Astext is entered, sized, and repositioned, rows of text may begin to overlap each other,
or may appear with too much spacing between them. To set the Row spacing back to
what it should be (based on the text on the row), press the “Reset Row Spacing” button
in the shortcuts window to reset the height of every row of the page.
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Cursor Movements
The cursor movement keys allow you to move the cursor around the screen. The cursor
can also be positioned with the mouse.

Cursor Up

The <- > key moves the cursor up one row unlessit is already on the top row of the page.
If the cursor is on the top row of the screen and you are editing a Credit Roll page, the
text will scroll down. This allows you to re-edit the text that has been scrolled off the
screen.

Cursor Down

The < > key moves the cursor down onerow. If this moves the cursor below the bottom
margin, and you are editing a Credit Roll page, the page will scroll up to keep the cursor
within the margins,

Cursor Left

The <~ > key moves the cursor |eft one character position. If the cursor is at the left
margin, the cursor will move to the end of the next row up (provided it’s not already on
the top row). If the pageisa Crawl, the text will scroll right to let you re-edit the text that
has already crawled off the |eft side of the screen.

Cursor Right

The <® > key moves the cursor right one character position. If this moves the cursor
beyond the end of the row, the cursor will move to the beginning of the next row unless
the page isa Crawl page. In this case the text will scroll to the left to keep the cursor
within the margins.

Home

Press the <Home> key to move the cursor to the first character of the row. If the cursor is
already on the first character of the row, pressing the <Home> key will move the cursor to
the first character position of the first row of the layer. If the pageisa Credit Rall, it will
scroll down until the very first row of the page is shown. If the pageisa Crawl, the page
will scroll right to show the first character.

End

Press the <End> key to move the cursor to the last character of the row. If the cursor is
already on the last character of the row, Pressing the <End> key will move the cursor to
the last character of the layer. If the pageisaCredit Roll or a Crawl page, it will scroll
until the last character appears.

28



Page Up

Pressing the <Page Up> key will move the cursor to the last character on the screen
unless the page is either a Credit Roll or aCrawl. If itisaCredit Roll, it will scroll up
the height of the screen. If the pageisaCrawl, the text will scroll left the width of the
screen.

Page Down

Pressing the <Page Down> key will move the cursor to the home position screen unless
the pageis either a Credit Roll or a Crawl. If the page isa Credit Roll, the page will
scroll down the height of the screen (if there is text above the screen). If the pageisa

Crawl, it will scroll right the width of the screen (if there is text to the left of the screen).

Setting Cursor Position with the Mouse
The cursor can be moved with the mouse. Move the mouse pointer to the desired

position and click the left button. The cursor will move to the character being pointed to.
If characters are overlapped, continue to click the left button until the desired character is

selected.
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Chapter 4
Text Styles

One of the most amazing things about Power CG Plus, is the amount of control you have
over the text style. Thetext is made up of six different components. These are the
character, two edges, and up to three shadows.

Each of these six character components can be set to either a solid color, a vertical color
spread from the top to the bottom of the character, a color gradient that you can define, or
atexture.

Y ou can select a TrueType Typeface for the character and control the Height, Width,
Italics Angle, Rotation, Kerning, and the Blur of the character.

For each edge you can select the Edge Type, Direction, Depth, and the Blur. For any of
the three shadows you can select the shape (to be the same as the Character, Edge 1, or
Edge 2) and the offset from the character. The shadow can be offset from a character by
as much as 100 pixels horizontally and vertically.

Many of the text style attributes (height and width for example) are represented
numerically. These numerical attributes can be modified by controls that are either
absolute or relative. An absolute control will set all of the selected text to the new value.
A relative control will change all of the selected text by the same amount.

To illustrate the difference between absolute and relative, let's assume there is aword on
the screen. Thefirst character of the word is 50 scanlines. The rest of the word is 25
scanlines high. If you select the entire word and use arelative control to increase the
height of the first character by 25 scanlines to 75 scanlines, the height of the rest of the
word will be increased by 25 scanlines to 50 scanlines.

If you use an absolute control to set the height of the first character to 60 scanlines, the
height of the entire word will be set to 60 scanlines (they won't maintain their height
relative to each other).
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Character Styles
To change the character style, select the Character Tab in the Control Tab Window.
The controls for adjusting the character style will be displayed as shown below.

Logos | Background - Image I B ackground - Colors | Page Transitions I
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This control tab window has 6 groups of controls to control numerical character
attributes. It also has a Cursor Handle Button, a selection box that lets you change the
Typeface, and a button that you can press when you want to load new Typefaces.

The numerical control groups are:

Height
Width
Italics
Rotation
Kerning
Blur

Each group of numerical controlsis made up of 4 controls. The top control in the group
(the one with the icon) is a drag button. The drag button is the relative control of the
group. To use the drag button, move the mouse over it, press the left mouse button, and
drag the mouse. Moving the mouse up or to the right will increase the value. Moving the
mouse down or to the left will decrease the value. The other three controlsin the group
are the absolute controls.

The absolute controls consist of a number box and two small buttons to the right of it for
increasing and decreasing the value. The value in the number box can be entered directly
by moving the mouse over the number, double clicking the mouse (thiswill highlight all
of the digitsin the number), and entering the new value. The value can be increased by
pressing the increase button to the right of the value. If you hold this button down the
value will continue to increase until you release the button. To decrease the value, press
the decrease button. Holding down this button will continue to decrease the value until
you release it.
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If you move the mouse over the number, then press and hold down the left mouse button,
you can change the value by moving the mouse. Moving the mouse up or to the right will
increase value. Moving the mouse down or to the left will decrease the value. When you
have the desired value, release the left mouse button.

The Cursor Handle Button performs two functions. It allows you to turn the cursor
handles on and off. It's also there as areminder asto what each cursor handle is used for.

The Typeface selection box lets you select a different Typeface and thereisan "Add New
Typefaces" button that you can press when none of the 25 typefaces that are currently
loaded are what you want.

Let's explore these buttons alittle closer. Create anew page by pressing the New Page
icon in the toolbar and select a Still page type. From the style gallery select a reasonably
sized text style. Then typetheword TEST in all capita letters. Pressthe home key to
move the cursor to the first “T” in the word “TEST".

Move the cursor over to the Height Drag Button, press and hold down the left mouse
button and move the mouse up. Notice that the size of the character increases. Release
the left mouse button.

Drag the cursor across the entire word to select it. Move the mouse over the Height Drag
Button, press and hold down the left mouse button, and move the mouse down. Notice
that the height of every character in the word decreases by the same amount. The value of
the number box is changed to display the current height of the first character that is
selected.

Now let's see how the absolute controls behave differently. Move the mouse to the height
number box and double-click it. Thiswill highlight al of the digits. Re-enter the digits
exactly asthey were before (if they were originally 48, enter 48) and press the <Enter>
key. Noticethat all of the characters became the same size as the first character, they did
not maintain their relative character heights.

The height of the characters can be varied and set to any size between 600 scanlines high
and negative 600 scanlines high. The negative character height will draw the characters
inverted (upside down). Try experimenting with the height controls to see how they
affect the characters.

Changing the width of the characters will make them appear thinner or wider. The width
can be varied anywhere between 10 percent of normal (very thin) to 500 percent of
normal (five timestheir normal width). A width of 100% is the normal width for the
character. Try experimenting with the width controls to see how they affect the
characters.
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Theitalics angle of the text can be varied up to 45 degreesin either direction. A negative
italics angle will slant the charactersto left, the positive italics angle will slant the
charactersto theright. Try experimenting with the italics controls to see how they affect
the characters.

Each individual character, or group of characters, can be rotated up to 360 degreesin
either direction. A positive value will rotate the text clockwise, while anegative value
will rotate the text counter clockwise.

The kerning controls allow you to change the spacing between the characters. A negative
value will move the characters closer together. A positive value will move the characters
further apart.

The amount of blur on the characters can be changed using the blur controls. A blur
value of 2 gives you a crisp sharp character, a blur value of 12 gives you a very fuzzy
character. The blur of the character and the blur on each of the two edges can be set
independently of each other.

Cursor Handles

Cursor Handles are points on the cursor that allow you to click and drag the text around
the screen. With these handles you can move, size, rotate, and italicize thetext. The
Cursor Handle Button (on the right hand side of the character tab window) is used to turn
the Cursor Handles on and off. It also has alittle diagram that shows what each handleis
used for.

Turn the cursor handles on by pressing the Cursor Handle Button. Notice that eight small
boxes appear around cursor. Each of these small boxesisahandle. Y ou can move the
selected text by clicking on the handle in the lower left corner and dragging the mouse.
Each time you pause the mouse, the text will be redrawn at the new position. If you only
want to move the text horizontally (without affecting the baseline alignment) you can use
the handle on the left side of the cursor. If you accidentally move the mouse vertically
while dragging this handle, the text will not move vertically. Using the handle on the
bottom of the cursor will only move the text verticaly, it will not allow it to move
horizontally.

Use the handle at the top of the cursor to adjust the height of the characters. When you
change the size of the cursor by dragging this handle, the height of the text will be
changed to match the cursor size. The relative size of each selected character will be
maintained.
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Use the handle on the right side of the cursor to adjust the width of the text. Dragging
this handle left or right will change the relative width of each selected characters. When
you change the width of the cursor by dragging this handle, the relative width will be
adjusted to fit within the new cursor size.

Dragging the handle on the upper right corner of the cursor will adjust both the height and
width of the text. Dragging the handle on the lower right corner of the cursor will rotate
the selected text. Dragging the handle on the upper left corner of the cursor will change
theitalics angle of the text.

When you are through using the cursor handles, and you no longer want them to be
displayed, pressthe Cursor Handle Button again to turn the handles off.

Typefaces

The typeface selection box shows the current typeface. If you open this box up by
pressing the down arrow on the right hand side, all of the typefaces that are currently
loaded will appear. Click on any typefacein thislist to select it. When anew typefaceis
selected, the selected text will be redrawn with the new typeface.

Loading New Typefaces

The Power CG Plus can load two types of typefaces, Cayman Graphics format or
TrueTypeformat. The Cayman Graphics format isaproprietary format. The typefaces
that came with the program are in thisformat. The TrueType format is the most popular
format and has the widest selection of typefaces. Y ou can load up to 25 typefaces for each
project. When you use typefaces on a page, the system keeps track of which typefaces are
needed to display the page. If the loaded typefaces do not match the typefaces needed by
the page, the correct typefaces are automatically loaded.

35



To load new typefaces press the "Add New Typefaces" button. When thisis done the

Load New Typefaces window will appear as shown below.
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The typefaces that are currently loaded are listed on the right hand side of this window.
The typefaces that are available to be loaded (in the current directory) are listed on the left
hand side. The current directory is displayed in the center.

Select the typeface format (TrueType or Cayman Graphics) that you want to load. All of
the typefaces in the current directory of the selected format will appear on the left side
under “Available Typefaces”. If thetypefaces are TrueType, the full name of the
typeface is shown in the actual typeface (for example, the name Helvetica will appear in
the Helvetica typeface, the name Times New Roman will appear in the Times New
Roman typeface). You can use this feature to preview the typefaces without the need to
load them first. To get a better ook at atypeface, click onitinthislist. A larger sample
of this typeface will appear.

If the desired typeface is not in the current directory, select the proper directory. Your

system typefaces are usually stored in the "C:\WINDOWS\SYSTEM" or
"C:\WINDOWS\FONTS" directory\folder.

36



The typefaces do not need to beinstalled on your system. Y ou can load typefaces directly
from aCD-Rom. When you load a TrueType typeface, a copy of it is made on your hard
drive (inthe POWERCG\TYPEFACE folder). Y ou can then remove the CD-Rom and
the program will still be able to find the typefaces when it needs them.

To load anew typeface, select the position that you want to load it into in the “Loaded
Typefaces” list, select the typeface to load in that position from the “Available
Typefaces” list, then press the load button. The new typeface will appear in the
“Loaded Typefaces” list and the next position in the “Loaded Typefaces” list will be
selected. The typeface may also be loaded by double-clicking on it in the “Available
Typefaces” list.

When you have finished loading typefaces press the “Done” button and the Load New
Typefaces window will disappear. Notice that the new typefaces now appear in the
Typeface Selection Box.

Scope Selection

Now that we have the basics of character attributes down, let's try something alittle more
advanced. Create anew page, and set the Page Typeto the Still. Set the character Height
to 24 scanlines, the Width to 100 percent, Italics to O degrees, and Rotation to O degrees.
Set the Kerning to 0 and the Character Blur to 2. Selected a clean/easy to read typeface
such as Boston Black, Futurist, or Bassett Bold. Now type the following three lines of
text:

The quick Brown Fox
jumped over the
lazy dogs back.

Place the cursor on the M in the word “jumped” and select a different typeface. Notice
that only the the character under the cursor changed. If the toolbar isvisible (above the
title compose window) you'll see a selection box with thewords "Selected Text". This
iscaled the“Scope Selection Box.” This selection box is used to determine how much
text the Text Style changes will affect. If the toolbar is not visible, display it by selecting
the “Display Toolbar” command from the “View” menu. Open this box by pressing
the down arrow and the following options will appear:
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Selected Text
to End of Word
Entire Word

to End of Row
Entire Row

to End of Layer
Entire Layer
Entire Page

Change this selection to “to End of Word”, then change the rotation angle to minus 10
degrees. Notice that every character from the M to the end of the word is rotated. Go
back to the toolbar and change the selection to “Entire Word”. Increase the height to 48
scanlines. Notice that the height of the entire word changed. Now select the “to End of
Row” entry from the scope selection box and set the width to 50 percent. Notice that all
text from the cursor position (the M in jump) to the end of the row changed its’ width.

Set scope to “Entire Row” and select anew typeface. Every character on the row is now
drawn with the new typeface. Select “to End of Layer” from the scope selection box
and set the height to 60 scanlines. Every character from the cursor position to the end of
the row, and every character on every row after the cursor changed to the new height.
Now select “Entire Layer” asthe scope and select a new typeface. Notice that every
character on the page changed to the new typeface. Thereis one more entry in the scope
selection box that we have not discussed yet. Itis“Entire Page”. Selecting thisentry
would change all of the text on all of the layersif we had multiple layers on the page.
You'll find out more about this when we discuss Layers in Chapter 6.

When “Selected Text” is chosen, the changes are applied to the character or group of
charactersthat are selected by the cursor. To select multiple characters, move the mouse
to the first character to select, hold down the left mouse button, and drag the mouse to the
last character to select. Dragging the mouse will not select text that is on more than one
row unless the <Shift> key is held down while the mouse is being dragged.

Row Spacing (Leading)

When we increased the size of the text, the rows of text overlapped each other.
Sometimes we want this effect, other timeswe don't. If you want to adjust the row
spacing to match the text, pressthe “Reset Row Spacing” button in the“ Shortcut
buttons” window (to the right of the title compose window). Thiswill adjust the row
spacing (leading) so that the rows don't overlap.

With “Entire Layer” still selected as the scope, set the Height to 24 scanlines and the
Rotation angle to 0 degrees. Now there is too much space between the rows. Pressthe
“Reset Row Spacing” button again and the excess row spacing (leading) will be
removed.
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Edges
To change the Edge Styles, select the Edges Tab in the Control Tab Window. The
controls for changing the edges will be displayed as shown below.
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This control tab window has 2 complete sets of controls for controlling both edges. The
controls on the left are used to set Edge 1, the controls on the right are used to set Edge
2. Since both sets of controls areidentical, we will discuss both of them at the same
time.

Each set of edge controls are made up of four groups of controls. One group selects the
Edge Type, another group selects the Direction of the edge, and there are two groups
used to control the numerical values Edge Depth and Edge Blur.

Edge Type

The Edge Type s controlled by a group of five buttons. These buttons are called radio
buttons because only one button can be selected at the time (just like buttons on the car
radio). Pressing one button will deselect the others. These buttons are used to select the
edge type and to indicate the current edge type. The edge types that can be selected are
asfollows:

A

—1 No Edge
Shows just the characters without any edge

2= Full Surround Border
Displays the characters with a border around them. The border has equal depth on all
sides of the character. The depth of the border is set by the Depth controls
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Al Extruded Shadow

Extruded Shadows appear connected to the character. This gives the characters sort of a
three-dimensional look. The direction of the shadow is determined by the Direction
controls, and the depth is set by the Depth controls.

Al Highlighted Shadow

A Highlighted Shadow is very similar to an extruded shadow. However afine border
appearsto highlight the character. The direction of the shadow is determined by the
Direction controls, and the depth of the shadow is set by the Depth controls.

ﬁl Offset Shadow

An Offset Shadow is separated from the character. Thismakesit appear as though the
character is above the background and is casting a shadow on it. The direction of the
shadow is determined by the Direction controls, any offset of the shadow is set by the
Depth controls.

Pressing the appropriate button selects the edge type, that button then appears depressed
to indicate the current edge type.

Edge Direction
The direction of the extruded shadow, highlight shadow, and offset shadows can be
controlled. The direction is controlled by the direction control group shown below.

— Diirection

I i
o\
=

There are eight buttons around the outside of this group. Each button represents one of
the eight possible directions (Upper Left, Up, Upper Right, Right, Lower Right, Down,
Lower Left, and Left). Pressing one of these buttons will select the corresponding
Shadow Direction. When the direction is selected, the button appears depressed to
indicate the current direction.

Thereis also a button/indicator in the middle of the Direction Selection Buttons. This

also indicates the current shadow direction. Pressing this button will advance the shadow
direction clockwise to the next direction.
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Edge Depth

The depth of the edge is a numerical parameter that can be varied from 0 to 99 pixels. An
edge depth of zero will not be seen unless you make the edge blurier than the character.
Setting the edge depth to 99 scanlines will make an extremely deep edge that may slow
down the drawing of the characters. If you want areally deep edge like this, | suggest that
you compose the page using asmaller edge first. Thislets you compose the page without
being slowed down too much. After the text istyped, you can make the edges as deep as
you want. The edge depth will not have any effect on the edge if the Edge TypeisNo
Edge.

The numerical controlsin this group work just like the numerical controls on the
Character Tab.

Edge Blur

The amount of blur on the edges can be changed by the controlsin this numerical control
group. A Blur setting of 2 gives a crisp sharp edge, a blur setting of 12 gives you a fuzzy
edge. The Blur of each edge and the character can be set independantly of each other.

Shadows

The Power CG Plus can display each character with 3 independant shadows. These are
called Shadow 1, Shadow 2, and Shadow 3. Shadow 1 isdrawn behind the character
and in front of Edge 1. Shadow 2 isdrawn between Edge 1 and Edge 2. Shadow 3
isdrawn behind Edge 2. Y ou can control the shape and offset (horizontal and vertical)
of each shadow independantly.

To change the Shadow Styles, select the Shadows Tab in the Control Tab Window.
The controls for changing the shadows will be displayed as shown below.
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This control tab window has 3 compl ete sets of controls for controlling all three shadows.
The controls on the left are used for Shadow 1, the controlsin the middle are used for
Shadow 2, and the controls on the right are used for Shadow 3. Since all three sets of
controls are identical, we will discuss all three of them at the same time.

41



Each set of shadow controls are made up of 2 groups of controls. One group selects the
Shape of the shadow, the other group selects the shadows' Offset.

To help demonstrate the Shadows, we should make both of the edges look significantly
different from the character as well as each other. Select the “Character” Tab. Set the
Height to 48 scanlines, the Width to 100%, the Italics and Rotation anglesto O degrees,
and the Blur setting to 2. Now select the “Edges” Tab. Set the Edge 1 typeto “Full
Surround”, set its' Depth to 8 pixels, and set its Blur to 7. Set the Edge 2 typeto
“Extruded Shadow”, set it’sdirection to “Lower Right” set its Depth to 30 pixels, and
its’ Blur to 12.

We also need to set the character, edge, and shadow colors so we can easily tell them
apart. Warning - this could end up looking ugly. Select the “Colors” Tab, thiswill
display the color controls. Pressthe “Palette” button to display the preset color palette.

Pressthe “Character” button in the “Component” control group to tell the system that
we want to change the Character color (make sure both the “Top Color” and “Bottom
Color” check boxes are marked). Scroll down in the color palette until the* White” entry
appears and select it as the character color. Pressthe “Edge 1” button, make sure both
the“Top Color” and “Bottom Color” check boxes are marked, and select a*“ Reddish”
color for it from the color palette. Pressthe “Edge 2” button, , make sure both the “Top
Color” and “Bottom Color” check boxes are marked and select a“Greenish” color for it
from the color palette.

Let’s set the Shadow colors now. Press the “Shadow 1” button, make sure that both the
“Top Color” and “Bottom Color” check boxes are marked, and select a“Blue’ color for
it. Pressthe “Shadow 2” button, make sure that both the “Top Color” and “Bottom
Color” check boxes are marked, and select a“Magenta’ color for it. Press the “ Shadow
3” button, make sure that both the “Top Color” and “Bottom Color” check boxes are
marked, and select a“Yellow” color for it. Now we can definately tell which component
(Character, Edge, and Shadow) iswhich.

Select the “ Shadows” tab to display the “Shadows Control Window”. Type the word
“SHADOWS” on the screen then drag the mouse over the word to select the entire word.

Select “None” as the shape of all three shadows. Use the “ Offset” controls for each
shadows to set the offsets of each shadow to the following:

Vertical Offset Horizontal Offset
Shadow 1 8 9
Shadow 2 -26 -27
Shadow 3 -40 30

42



Shadow Shape
The Shadow Shape control group is made up of 4 buttons (to select the shape of the
shadow) and an indicator (to indicate the current shadow shape).

A shadow can be set to be the same shape as the Character, Edge 1, Edge 2, or it can be
turned off. To turn the shadow off, pressthe “None” button. To make the shadow the
same shape as the character, pressthe “Character” button. To make the shadow the
same shape as edge 1, pressthe “Edge 1” button. And so on.

As each shape is selected, the Current Shadow Shape Indicator (below the shape
selection buttons) will change to indicate the current shadow shape. Y ou can aso click
on the Current Shadow Shape Indicator to advance the shape of the shadow to the
next shape.

Select the different shapes for Shadow 1. Notice that when you select the shape for the
shadow, it appears as blue (earlier, we selected blue as the shadow one color) behind the
Character and in front of Edge 1 (the red edge). Do the same for Shadow 2 and Shadow

3. Notice that Shadow 2 (magenta) is drawn behind Edge 1 (the red edge) and in front of
Edge 2 (the green edge). Shadow 3 (yellow) is drawn behind Edge 2.

Set the shape of Shadow 1 to “Character”, the shape of Shadow 2 to “Edge 1”, and the
shape of Shadow 3 to “Edge 2”.

Shadow Offset

The shadows can be offset from the character in any direction in single pixel increments.
The shadows can be offset horizontally from the character by as much as 100 pixelsin
either direction. A negative value offsets the shadow to the left. A positive value offsets
the shadow to the right. The shadows can be offset vertically from the character by as
much as 100 scanlines. A positive value places the shadow above the character, a
negative value places the shadow below the character

The shadow offset controls for each shadow work very similar to the numerical controls

in the “Character” and “Edges” tabs. The offset drag button (shown below) can be used
to control both the vertical and horizontal offsets.

M

Dragging the mouse left or right will adjust the horizontal offset. Dragging the mouse up
or down will adjust the vertical offset.
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Click onthe "H" in shadowsto select it. Click onthe Shadow 1 Vertical Offset
Number Box and drag the mouse down. The blue shadow (Shadow 1) moves down
when you move the mouse. Click on the Shadow 1 Horizontal Offset Number Box
and drag the mouse to the right. Shadow one moves to the right when you move the
mouse.

Notice that Shadow 1 on the “H” character isin adifferent position than Shadow 1 on the
other characters. Drag the mouse across the entire word to select all the characters.
Position the mouse over the Shadow 1 Offset Drag Button and press the left mouse
button. Now move the mouse around while holding down left button. Notice that
shadow 1 on all of the characters moves with the mouse, and that Shadow 1 on the H.
character maintains its position relative to the rest of the characters.

Try experimenting with the offsets for Shadow 2, and Shadow 3. You'll see that they
work exactly the same way as Shadow 1.

Save this page with the name “SHADOWS”.

Text Colors
Select the “Colors” Tab in the Control Tab Window to adjust the Text Colors. This
will display the Colors Control Window (shown below).
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The Colors Control Window has three main sections. The first section (on the l€eft) is
used to select which component of the text (character, shadow 1,edge 1,shadow 2, edge 2,
or shadow 3) to change the color of. The next section is agroup of buttons used to select
the method of choosing a color (color picker, color sliders, color palette, color gradient,
or textures). The last section has the controls used in choosing acolor. These controls
change based on the method of choosing a color that you have sel ected.
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Text Component

The component group of controls contains six buttons for selecting which component of
the text to change the color of, (character, edges, or shadows). To change the character
color, press the “Character” button. To change the color of edge 1, press the “Edge 1”
button. And so on. When anew text component is selected, the color indicator box in
the lower left corner of this group is changed to display the current color. The color
indicator box displays the current color asit is being modified.

The component section of the Colors Control Window has an indicator to show the
current color of each text component. These boxes display the text componentsin the
same order that they will appear on the screen. The front box of thisindicator shows the
current Character color. The box behind it (that is offset down and to the right of it),
shows the current Shadow 1 color. The box that is behind to both the Character and
Shadow 1 indicators, displays the current Edge 1 color. The box behind and offset
down to the right of the Edge 1 indicator, displays the current Shadow 2 color. The box
that is behind both the Edge 1 and Shadow 2 indicators, displays the current Edge 2
color. The box behind all of the othersisthe Shadow 3 color indicator.

If you click on any of these indicators, the component that it represents will be selected.
The appropriate component selection button will appear depressed to indicate the current
component. The color indicator box will aso be changed to the color of the selected
component.

Color selection methods

There are five different methods of selecting a color. These methods are as follows:
Color Picker
The Color Picker lets you select the color using avisual approach

Color Sliders
The Color Sliders lets you select the color using a numerical approach.

Color Palette
The Color Palette |ets you select a color from a palette of 64 preset colors.

Color Gradient

A color can be selected from a group of 64 user defined color gradients. This may
be either alinear gradient with up to 16 color points that can be rotated up to 90
degreesin either direction. It can also be an area gradient that can have four or
five color points defined.

Color Texture
A Color Texture can be selected from any of the 16 textures that are currently
loaded.
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Before we begin experimenting with changing colors of the text, we should have some
text that uses both of the edges and al three of the shadows. Let's open the “ Shadows”
page (if it isn't already open) that we created earlier. Drag mouse across the entire word
to select all of the characters. We are now ready to play with the colors.

Color Picker
Press the “Picker” button to display the color picker controls. The color picker controls
are shown below.
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W Tap Calar Trans:
Shderz I
¥ Bottom Color ; ;I
Palette
e Yideo:
Gradient s II:I -
Pick Caolar
Textures from Screen

The top and bottom of each character component can each be set to different colors.
There are two boxes to select whether we want to change the top color, the bottom color,
or both. If the top and bottom colors are different, the text will be drawn with a smooth
color spread between the two colors.

Below these check boxesis an lllegal Color Indicator. If the selected color exceeds
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

Below theillegal color indicator isthe “Pick Color From Screen” button. Pressing this
button will change the appearance of the mouse to look like an eye dropper. Move the
mouse to position on-screen that you want to copy the color of, press the left mouse
button and the color under the mouse will be selected.

To the right of these controlsisthe Hue Picker. Thisletsyou select the hue (red, green,
blue, etc.) of the color. Place the mouse over this control, and press the left mouse button
to select the desired hue. When the new hue is selected, the text will be redrawn with the
new color, and the Color Picker Area (to the right of the Hue Picker) will also be drawn
with the new hue.

Once the Hue is selected you can now pick the color. Place the mouse over the Color
Picker Area and press left mouse button. Thiswill select the color under the mouse. If
you hold down the left mouse button while you move the mouse, the text will be redrawn
with new color each time you select a new color by moving the mouse.
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Y ou can also control the Transparency of the color. The transparency setting can make
the color fully opague, semi-transparent, or fully transparent. When a color is semi-
transparent, the text component is drawn astinted over whatever isbehind it. When the
color isfully transparent, it can’t even be seen on the screen. Setting the transparency
level to 0 makes the object fully opague. Setting the level to full (255) makes the object
fully transparent. Any value in between makes a color that is semi-transparent.

There are avariety of ways to change the Transparency level. Thelevel can be
increased by pressing the increase button to the right of the transparency number box. If
you hold this button down the level will continue to increase until you release the button.
To decrease this value, press the decrease button. Holding down this button will continue
to decrease the value until it isreleased. If you move the mouse over the transparency
number box, then press and hold down the left mouse button, you can change the value by
moving the mouse. Moving the mouse up or to the right will increase the value. Moving
the mouse down or to the left will decrease the value. When you have selected the
desired value, release the left mouse button.

The value of the transparency level can be entered directly. Do this by double-clicking
the transparency number box (thiswill highlight all of the digitsin the number), typein
the new value and press the enter key.

The color can be also mixed with background video. Setting the video level to avalue of
zero makes the object the selected color. Setting the video level to full (255) draws the
object with background video. Any value in between makes the object appear as
background video that istinted by the selected color. For some very interesting effects,
try blending colors, background video, and transparency over a background graphic
image.

The background video level can be adjusted in the same way as the transparency level.
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Color Sliders
Pressthe “Sliders” button to display the Color Slider controls. The Color Slider
controls are shown below.
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The top and bottom of each character component can be set to different colors. There are
two check boxes to select whether we want to change the Top Color, the Bottom Color,
or both the top and bottom colors. If the top and bottom colors are different, the text will
be drawn with a smooth Color Spread between the two colors.

Testures | Tranz.

Below these check boxesisthe lllegal Color Indicator. If the selected color exceeds the
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

The Power CG has two (2) numerical systemsfor defining colors. They are RGB (Red,
Green, Blue) and HLS (Hue, Luminance, Saturation). Both of these systems are used to
define the same thing (like yards and meters). Adjusting one will automatically change
the other. Y ou can select which method to use by pressing either the RGB or HLS button.
Y ou can switch back and forth between the 2 color systems at any time just by pressing
the appropriate button.

The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking
the number box and entering the new value with the keyboard.
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Color Palette
Press the “Palette” button to display the preset color palette. The Color Palette is
shown below.
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The preset Color Palette can hold 64 preset colors. These preset colors are displayed in
thiswindow. Not all of the preset colors can be displayed at one time, so there is a scroll
bar on the right hand side of the color palette entries. Use this scroll bar to scroll through
all of the preset colors.

The top and bottom of each character component can be set to different colors. There are
two check boxes to select whether we want to change the Top Color, the Bottom Color,
or both the top and bottom colors. If the top and bottom colors are different, the text will
be drawn with a smooth Color Spread between the two colors.

Below these two check boxesisthe lllegal Color indicator. If the selected color exceeds
the NTSC or PAL limitations, this box will appear red to indicate that you have selected
anillegal color. Otherwise this box will appear green.

To select acolor from the preset color palette, position the mouse over the desired color
and click the left mouse button. Y ou can change acolor in the preset Color Palette by
double clicking the entry that you want to change. For more information about modifying
the preset Color Palette, see this section "Modifying the Color Palette” in chapter 12.

Thiswindow also has a button labeled "Background Video". Pressing this button will
set the color so that the text will be drawn with background video.
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Color Gradients
Pressthe "Gradient" button to display the color gradients. The Color Gradients
selection window is shown below.

Picker

Shderz

Palette
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Textures

Double Click on an Colar Gradient bo modify it

64 color gradients can be loaded into the system at one time. The Color Gradients that
are currently set are displayed in thiswindow. Not all of the color gradients can be
displayed at one time, so there isascroll bar on the right hand side of the Color Gradient
entries. Usethis scroll bar to scroll through all of the color gradients that are currently set
for the project.

To select acolor gradient, position the mouse over the desired gradient and click the left
mouse button. The text will then be drawn with the selected color gradient. Y ou can edit
a Color Gradient, or build anew one, with the gradient builder. To do this, double-click
the Color Gradient that you want to modify. For more information about using the
gradient builder, see the section "Building Color Gradients" in chapter 12.

Color Textures
Pressthe "Textures" button to display the Color Textures selection window. The Color
Textures selection window is shown below.
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16 full Color Textures can be loaded into the system at onetime. The Color Textures that
are currently loaded are displayed in thiswindow. The Textures are displayed large
enough so that you can easily see what the texture looks like. Not all 16 textures can be
displayed in thiswindow at one time, so thereisascroll bar on the right hand side of the
textures. Usethis scroll bar to scroll through all of the textures that are currently loaded.
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To select a Color Texture, position the mouse over the desired texture and click the left
mouse button. The text will then be drawn with the selected texture. Y ou can load a new
texture by a double-clicking on the one that you want to replace. When thisis done you
will be asked to specify which graphic image you want to load as a texture. For more
information about loading graphic images as Color Textures, see the section "Loading
Textures" in chapter 12.

Grabbing and Applying Attributes

When you enter new text it is entered with the Current Text Attributes. The text
attributes specify how the characters, edges, and shadows will appear. The Current Text
Attributes are the attributes displayed in the Character, Edges, Shadows, and Colors
control tab windows. These include the following:

Typeface

Character Size

Italics and rotation angles.

Kerning

Blur (character and edge)

Edge Style (type, depth, direction)
Shadow A ppearance (shape and offset)
Colors (character, edges, and shadows)

When you overwrite text, the text keeps the attributes of the text that you are overwriting.
If you would like to apply the Current Text Attributes to text that is already on the page,
use the "Apply Text Attributes” command. Select the text that you want to change the
attributes of, and press the "Apply Text Attributes™ button in the Shortcut Buttons
window.

If you want to grab the text attributes from text that is on the page, pressthe "Grab Text
Attributes” button in the Shortcut Buttons window. Thiswill make the text attributes
of the character under the cursor, the Current Text Attributes. The new character
attributes will then be displayed in the Character, Edges, Shadows, and Colors
control tab windows.
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Text Style Gallery

The"Text Style Gallery" window is used to hold preset text styles. Thisisthe window
on the right side of your screen with all of the different type of "A's" init. The Text
Style Gallery isdesigned to give you quick accessto text styles that you will use
frequently throughout the project. Y ou can save 64 different preset text stylesin the Text
Style Gallery. However, you are not limited to just these 64 styles.

Before we begin, create a new page by pressing the "New Page" button on the toolbar.
The program will warn you that you are about to erase the current page. Since we don't
have a page that isreally worth saving, pressthe "Yes" button. When the program asks
you which type of page you want to create, select "Still*. Y ou now have a new blank
page to work with.

To enter text using one of the preset styles, select the desired text style (by clicking on it)
and start typing. Any text that is entered will appear with the selected text style. To
select a different preset text style, click on it and start typing again.

Select atext style that looks interesting and type "This is my first preset style". Select
another preset style and type "This is another one".

To change the style of text that is already on the screen, select the text, then click on the
style that you want to set it to. Move the cursor to the first character and select another
style from the style gallery. Now, move the cursor to the next character and select
another style. Continue to do thisfor every character of the first two words of the page.

Select the word "first” by moving the mouse to the "f*, press the left mouse button, and
drag the mouse over to the "t" until the entire word is selected. Then select another text
style. Notice that the entire word is changed.

Select the Character tab in the Control Tabs Window and adjust the Height of the
word "first". Even though the character style was set using a preset style, you can still
modify the style of thetext. Soif you have atext style that is amost what you want, go
ahead and select it, then modify the attributes of the text you just changed the style of,
doing thiswill not affect the preset style in the style gallery.

Y ou can change the preset text styles. Create a character on the page that has the style
that you want to use as a preset, place the cursor on it, and move the mouse pointer to the
entry in the Text Style Gallery that you want to set to this style, and press the right
mouse button. A pop-up menu will appear. Select the "Set Style” command. The text
style of the cursor character will be copied to the style gallery.
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There are too many preset text stylesto be shown at one time in the text style gallery.
Y ou can use the scroll bar to scroll through the preset text styles. | like to group styles
that are used together, near each other in the Text Style Gallery.

Save this page to the disk by pressing the "Save Page" button on the toolbar. Give the

page the name "STYLES" and press the "Save" button. Y ou should seeitsPicon inthe
project manager window.
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Chapter 5
Moving Text

Once the text has been entered, it can be moved around and positioned. This can be done
either automatically or manually. Automatic positioning of pages consists of word
wrapping, word unwraping, centering the text between the margins, justifying the text to
the margins, or removing excess row spacing from between the rows.

Manual positioning of the text allows you to move the text to nearly any position on the
screen.

To do automatic text positioning, use the “Postioning Controls” (shown below). You
can display there controls by selecting the “Positioning” tab in the Control Tab Window.
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Word Wrapping and Unwrapping

Let's start with a fresh page by pressing the "New Page" button on thetoolbar. A
warning may appear telling you that the current page is going to be erased. If this
happens pressthe "Yes" button. Some systems will display a dialog box asking you to
select the page type. If this happens, press the "Still"* button. Y ou now have a new page
to work with.

Set the character height to 48 scanlines, and the character width to 100%. Now enter the
following text without pressing the <Enter> key "This Power CG software is really
pretty easy to use". Notice that when you got to the right side of the screen, the cursor
automatically went to the beginning of the next row.

Some of the words extend beyond the right margins. There are two common methods of
fixing this. The first method isto make the text smaller so that it will fit. The other
method is to wrap the words that extend beyond the margin to the next row. Since this
section deals with word wrapping and unwrapping, let's try wrapping the words.
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The"Word Wrap/Unwrap" section of the "Positioning Controls Window" has four
buttons. These buttons are as follows:

E Wrap One Word

E Wrap All Words

E Unwrap One Word

5 Unwrap All Words

Word Wrap checks to seeif the last word of the row extends beyond the right margin. If
it does, the word is moved to the beginning of the next row. Word Unwrap checks to see
if the first word of the next row will fit on the current row. If it will, the word gets moved
up to the row above.

Move the cursor to the home position by pressing the <Home> key twice. Pressthe
"Wrap One Word" button (in the positioning controls window). If the last word of the
cursor row extends beyond the right margin, it gets moved to the next row.

If there isaword that needs to be wrapped, one word gets wrapped to the next row each
time you press this button. If thereis not aword that needs to the wrapped, pressing this
button will move the cursor to the beginning of the next row. Pressthe"Wrap One
Word" button until all words that need it are wrapped to the next row and the cursor
moves to the next row. Y ou could continue to wrap the entire page thisway, but thereis
an easier way to doit. Pressthe "Wrap All Words" button. All of the words on the page
that need to be word wrapped are moved to the next row.

Select al of the text on the page by selecting "Entire Page" in the scope selection box on
the toolbar. Decrease the height of the text to 32 scanlines using any method that you
prefer. The rows got narrower so that you can now fit more text on them.

Move the cursor back to the home position by pressing the <Home> key twice. Pressthe
"Unwrap One Word" button. Thefirst word of the next row should move up to the end
of the cursor row if there'sroom for it. Pressthe "Unwrap All Words" button. Every
word on the page will unwrap to fill in the excess space at the end of each row.
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Row spacing (Leading)

Notice that when you decreased the height of the characters that the height of the rows did
not automatically get smaller. The rows now seem to be spaced too far apart. To set the
row to the height that they should be, pressthe "Preset Row Spacing" button in the
shortcut buttons window. The height of each row will automatically adjust to what it
should be for the height of the tallest character on the row.

Y ou can have more control over the rows spacing (leading) with the "Row Spacing"
controls. Display these controls (shown below) by selecting the "Row Spacing” tab in
the control tab window.

Logos I Background - Image I Background - Colors | Page Tranzitions
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These controls are used to increase/decrease the spacing between the rows. The row
spacing can be increased by pressing the "More" buttons. The row spacing can be
decreased by pressing the "Less" buttons. To set the row spacing back to what it should
be (based on the text on the row) press the " Set Default Row Spacing” button.

The buttonsin the "Change Row Spacing of" section of thiswindow are used to select
which row(s) we are going to change the row spacing of.

Cursor Row

Changes the row spacing of the row that the cursor is on.
Entire Layer

Changes the row spacing of every row on the current layer.
Entire Page

Changes the row spacing of every row on the page.
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Fine Positioning Text

Individual characters, words, rows, layers, and the entire page can be fine positioned in
single pixel/scanline increments. Characters can be moved to any position on the row and
can be made to completely overlap each other. Smaller characters can be positioned
inside of larger characters. Rows can even be positioned to alow text to overlap the text
of other rows.

There are three ways to fine position text around the screen. One method isto use the
cursor handles. Another method is to drag the text by moving the mouse while holding
down the right mouse button. The final method is to use the fine positioning buttons in
the positioning control tab window.

To use the cursor handles, select the character tab in the control tab window and turn the
cursor handles on by pressing the “Cursor Handles” button. Little rectangles will appear
around the cursor. These are the cursor handles. The handle in the lower |eft hand corner
will move the text both horizontally and vertically. The handle on the left side of the
mouse will move the text horizontally only. Any accidental vertical movement of the
mouse will not move the text vertically. The handle on the bottom of the cursor will only
move the text vertically. Accidental horizontal movement of the mouse will not move the
text horizontaly.

To move text with these handles, select the text to move by dragging the mouse over the
desired text. Position the mouse over the handle that you want to use and the cursor will
change to arrows that show which direction the text can be moved. Press and hold down
the left button of the mouse, then move the mouse. The text will follow the mouse until
you release the left mouse button.

Once you are through moving the text, you can turn off the cursor handles by pressing the
“Cursor Handles” button again.

Y ou can quickly move the text (both horizontal and vertical) without turning on the
cursor handles. To do this, select the text that you want to move and press and hold down
the right hand button of the mouse. Asyou move the mouse, the text will follow it until
you release the right mouse button.
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To use the fine positioning buttons to move the text, display the Fine Positioning
Buttons by pressing the "Positioning" tab in the control tab window. Thiswill display
the Positioning Controls Window as shown below.
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Use these buttons to do fine incremental positioning of text. The single arrow buttons will
move the selected text one pixel each time you pressit. The double arrow buttons move
the selected text in bigger steps.

The "Reset Text Position™" button will restore the text to its original (before it was moved)
position.

Centering and Justifying Text
The Positioning Tab Window has 8 types of centering and justifying controls. These are:

Left Justify
Notice how al of the lines are lined up with the left margin.

Right Justify
Notice how al of the lines are lined up with the right margin.

Horizontal Centering
Notice how al of the lines are centered between the left and right margins.

Justify to Left and Right Margins
Notice how al of lines are lined up with both the left and right margins.

Vertical Centering
Thetext is adjusted vertically to position it in the center of the screen.

Center Horizontally and Vertically

e e i 1

"'T“' Thetext is adjusted horizontally and vertically to position it in the center of the screen.
— Top Justify

““ || Thetext isadjusted vertically so that the top row is placed at the top margin.

‘L Bottom Justify
— The text is adjusted vertically so that the bottom row is placed at the bottom margin.
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The"Row" section of the "Positioning Controls Window" (shown below) has four
buttons.
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=

These buttons are used to control individual rows of text. Each row can be centered
horizontally or justified to the left margin, right margin, or both margins at the same time.

To center row, place the cursor on the row that you want to center and press the
"Horizontal Centering” button. The row is now centered horizontally between the | eft
and right margins.

To justify the row to the right margin, press the "Right Justify" button in the "Row"
section of the "Positioning Controls Window". This moves the text to the right so that
itisaligned to theright margin. Pressthe "Left Justify" button in the "Row" section.
The text moves to the left so that it is aligned to the left margin.

To justify the row to both margins at the same time, press the "Justify to Left and Right
Margins" button in the "Row" section. Thefirst character of the row is placed at the | eft
margin, and the spacing between the characters is adjusted so that the last character of the
row is aligned to the right margin.

To perform the centering and justifying functions on all of the rows of text on the page
(or on the layer), use the corresponding buttons in the "Layer/Page" section of the
"Positioning Controls Window" (shown below).
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This section has two buttons (Layer and Page) to select whether each operation will be
done on every row on the layer or every row on the page.
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Select the "Page" button to make the centering and justifying functions work on every
row of the page. Try pressing the "Horizontal Centering”, "Right Justify", "Left
Justify", and "Justify to Left and Right Margins" buttonsin the "Layer/Page" section.
Notice that the functions are now done to every row on the page.

Pressthe "Center Horizontal and Vertical" button (shown here) to center the entire
page (or layer) both horizontally and vertically.

N
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Pressthe "Top Justify" button (shown here) to move the entire page (or layer) to the top
margin.

n
ek

Press the "Bottom Justify" button (shown here) to move the entire page (or layer) to the
bottom margin.

[l

Pressthe "Vertical Centering” button (shown here) to center the page (or layer)
vertically between the top and bottom margins.

>l'le
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Chapter 6
Layers

The Power CG Plus has 1000 layers available for text, shapes, and logos. These layers
are completely independent of each other. Changing something on one layer will not
affect the text on the other layers. Each layer can be given aname. Each layer can be
moved in front of, or behind the other layers. Individual layers can be temporarily hidden
so that they do not cover up the other layers that you're working on.

To work with layers, use the "Layer Controls" (shown below). Y ou can display these
controls by selecting the "Layers” tab in the Controls Tab Window.
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" Hidden hold dowr the CTRL key ¥ Down 1 Layer
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Creating a New Layer

Select a character height of about 48 scanlines. Enter enough text to fill the entire screen.
Move the mouse near the left margin about halfway down the screen. Create anew layer
by holding down the <Ctrl> key while you press the left mouse button.

The cursor is now positioned where you clicked the mouse on the new layer. Notice that
the "layering order” list has anew entry called "layer 1". Thisisthetop layer in thelist,
so it will be the front layer on the screen. Now enter the text "This is a new layer".
Notice that the new text appearsin front of the original text.

Move the cursor to the second row of the text on the original (Main) layer by clicking the
mouse on it. Notice that the name of the “Main” layer appears on the current layer on the
status bar. Insert arow at the cursor position by holding down the <Shift> key while you
press the <Ins> key. The text on the Main layer moved down to make room for the row
of text. Thetext on Layer 1 did not move. That iswhat we mean when we say the layers
are completely independent of each other.
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Selecting a Layer

Y ou can select anew layer just by setting the cursor position to a character that is on that
layer. Move the mouse to any character on Layer 1 and click the left mouse button. The
cursor is moved to the character that you clicked with the mouse, and the status bar is
updated to show that you are now on Layer 1.

Y ou can also select anew layer from the "Layering Order” list. When thisis done, the
cursor will be placed on the first character of the selected layer.

Renaming Layers

When the new layers are created, they are given adefault name such as"Layer 1". When
that layer is selected the name appears on the status bar and in the "Layer Name" box in
the Layers Control Window. Y ou can change the name of the layer just by entering the
new namein the "Layer Name” box. When the name is changed, the name appears in
the "Layering Order” list and on the status bar.

Changing Layer Priority

When anew layer is created, it is given the highest priority so that it will be displayed in
front of all the other layers. The priority of each layer isdisplayed in the "Layering
Order” ligt". Thetop layer in thelist isthe highest priority layer and isin front of all the
other layers on the page. The bottom layer in thelist isthe lowest priority layer and is
behind all of the other layers. A layer isin front of al of the layersthat are listed below it
in the layering list, and behind all of the layersthat are listed above it.

Each layer can be moved in front of, or behind the other layers. This can be done using
the layer priority buttons (shown below).

Move layer to top
? this gives the current layer the highest priority, and
placesit in front of al other layers

Move layer up one layer
f this moves the current layer up 1 level in priority,
this placesit in front of the next layer up.

Move layer down one layer
* this moves the current layer down one level in
priority, this placesit behind the next layer down.

Move layer to bottom
i this gives the current layer the lowest priority, and
placesit behind all other layers.




A layers priority can aso be changed by dragging it from its current position to the new
position in the "Layering Order" list. Move the mouse to the layer that you want to
change the priority of in the "Layering Order" list. Hold down the left mouse button and
drag the layers name to the desired priority. The page will then be redrawn with the layer
displayed at the new position.

Hiding Layers

When you start getting alot of layers on a page, and you need to edit text that ison alow
priority layer, the text that you want to change may be difficult to see because of the
layersin front of it. There are two ways to make the low priority of layers more visible.
One way isto increase the layers priority, edit the text, then move the layer back to its
lower priority. The other method isto "Turn Off" the layersin front. Thisis done by
telling the program which layers you don't want to see.

On the right hand side of the Layers Control Window are 2 buttons (“ Displayed” and
“Hidden”). These buttons show whether or not the current layer is displayed or hidden.
To hide alayer, select the layer that you want to hide and press the "Hidden" button. The
page is then redrawn without the selected layer. To turn the layer back on, press the
"Displayed" button, and the page is redrawn with the layer.

Another really neat thing that hidden layers allows you to do it isto easily create multiple
pages that all have common information. Place the text that is common to al pages on
one or more layers. Place text that is common to more than one (but not all) pages on
other layers. Then compose the text that is unique to each page on its own separate layer.
This gives you a master page.

Copy the master page once for each page that you want to create. And hide the layers that
you do not want to show on each individual page. If you ever need to modify the text,
you can modify the master page (instead of each individual page) then copy the pages and
hide the appropriate layers again. This avoids any differences (such as positioning errors)
in the pages.
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Deleting Layers

If alayer has no text on it, you may want to deleteit. Y ou can do this by selecting the
layer and pressing the "Delete Layer" button in the Layer Controls Window. If thereis
text on the layer that you're trying to delete, a warning message (like the one below) will
appear telling you that if you delete the layer, all of the text on that layer will also be
deleted.

Layer contains text |

There iz text on the current layer,
If your proceed,
the test will be deleted

Do you want to delete the text?

If you want to delete the text that is on this layer, pressthe "Yes" button. Otherwise
pressthe "No" button.
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Chapter 7
L ogos
As many as 16 different full color logos can be placed on each page. The logos can be

loaded directly from GIF, TIF, TGA, BMP, or PCX images. If theimage used asalogo
has an alpha channel, the alpha channel is supported.

To add alogo to a page, select the “Logos” tab in the Logos Controls Window. Thelogo
controls will be displayed as shown below.
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If the cursor is currently on alogo, information about that logo is displayed in this
window. The name of the image file that contains the logo is displayed. The maximum
size (height and width) that the logo can be displayed is aso indicated by this window.

Placing a Logo on the Page

Thiswindow also hasan "Add New Logo" button. To add a new logo to the page,
position the cursor where you want the logo to appear. Y ou may want to create a new
layer for the logo, but you don't have to. Pressthe"” Add New Logo " button, and select
the graphic image that you want to use asthe logo. The logo will then be displayed at the
current character height. Once alogo is added to a page you can sizeit just like you
would a character.
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Sizing a Logo

The maximum size that alogo can be displayed on a page is 640 by 480 pixels or the
original size of the logo (whichever issmaller). If agraphic image was created at 100
scanlines high, it cannot be displayed larger than 100 scanlines.

When alogo isfirst loaded it is displayed at the current character height. The "Maximum
Height" and "Maximum Width" entriesin the Logo Control Window will be updated to
indicate the maximum height and width that this logo can be displayed.

To change the size of alogo, position the cursor on it, and then change the size of it just
asif it was acharacter. You can use the "Height" and "Width" controlsin the "Character
Controls Window” to vary the logos height and relative width. Y ou can aso use the
cursor handles to change the logos height and width.
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Chapter 8
Shapes

Shapes are boxes that you can control the roundness and the aspect ratio of. Once the
shape has been placed on the page you can size it, colorize it, add edges and shadows to
it, and evenrotateit. In fact you can do anything to a shape that you can do to a character
(except change the typeface of it). A “Foreground Shape” getsinserted into the current
layer at the cursor position. A “Background Shape” gets added to anew layer that is
automatically created behind the text that is currently selected.

To create or edit a shape select the "Shapes" tab in the "Control Tabs Window". The
shape controls window will be displayed as shown below.

Logos I Background - Image I Background - Colors I Page Tranzitions |
Character I Edges | Shadowsz I Colars I Lapers | Pozitioning | Row Spacing Shapes
———— Aspect Ratio Roundness————
Add
Foreqground
Shape
. | 1be1 I | 0%
Add | I | nE ]
Backaground
Shape . 4 . 4 .

Aspect Ratio

The “Aspect Ratio” of the shape can be changed from tall and skinny to very wide. The
aspect ratio can aso be changed by changing the relative width (using the Character
Width Controls). The character width does have alimited range of 10% to 500%. The
aspect ratio controls are used to extend this range.

Roundness

The “Roundness” of the shape can be set to any value from 0 to 100%. A Roundness of
0% creates a shape that has square corners. A Roundness of 100% creates the shape that
iseither acircle or an elipse (depending on its aspect ratio). A value between 1 and 99%
creates a box that has rounded corners. The amount that the corners are rounded is
determined by the Roundness setting.
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Foreground Shapes

Add aforeground shape by moving the cursor to the desired position and press the "Add
Foreground Shape" button. The new shapeisinserted at the cursor position. The
shapeis assigned the Current Character Attributes. To increase the width of the shape
using the aspect ratio controls, drag the aspect ratio dlider to the right. To decrease the
width, drag this dlider to the left. Use the “Roundness” control to adjust the roundness
of the shape. Dragging the “Roundness” dider to the right will make the shape rounder,
dragging it to the left will make it squarer.

Now that the shape is on-screen you can use the "Character”, "Edges", "Shadows",
and "Colors" controls to modify the various character attributes of the shape. The
program creates the shape asif it were a character. All of the controls that can be used to
change the appearance of a character, can be used to change the appearance of a shape.

Background Shapes

Enter the words "Background Shape" on the page. Drag the mouse across all the
characters of both words to select them. Now pressthe "Add Background Shape”
button. A new shapeis created behind the selected text. A new layer was automatically
created for this shape and placed behind the text.

This shape is exactly like the foreground shape except that it's on a separate layer. You
can change the character attributes just like you can aforeground shape or a character.
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Chapter 9
Background Color Boxes

The Power CG can display background color boxes over the background image (or
external video) and behind the text. Each background color box can be positioned and
sized to anywhere on the screen. The color box can be set to a solid color, a smooth color
spread between the top and bottom of the box, a color gradient (afour or five point area
gradient, or alinear gradient with up to 16 colors), or afull color texture. If the
background color boxes have a solid color, a color spread, or a color gradient, the
transparency and background video levels of each color point can be adjusted.

As many as 32 background color boxes can be used on each page. Each background
color box isassigned to its own layer. The background color layers are dways behind the
text layers and in front of the background image. The priority that each background color
box is assigned determines how they will appear when one background color box
overlaps another. A background color box that has a higher priority will appear in front
of color boxes that have lower priorities.

To create or edit a background color box select the "Background-Colors" tab in the
Control Tabs window. The Background Color Box Controls (shown below) will be

displayed.

Character I Edges I Shadows I Colors | Layers | Pozitioning | Fiow Spacing I Shapes I
Logog | Backaround - Image Background - Colors Fage Transitions

MHew Background Picker |
Calar Box ? v Top Calor Red '_J— |2E|5
Full Screen -m * FGE

Backaround Colar * ¥ Battorn Calar Green .—J_ |2EIE

Delste Backgiound _Pakte | " HLS

elete Backgroun

Blue | —4—— 205

Color Box * Gradient | Legal Color J— I

Convert Color Box
ta Shape Textures | Tranz.

———— [ video| —f——— [

Creating a New Background Color Box

To create a new background color box press the "New Background Color Box™ button.
A new color box will appear behind the cursor row. The background color box begins as
a semi-transparent gray that is the full width of the screen, and the height of the cursor
row.

The cursor appears to surround the new background color box. The cursor has six cursor
handles. Three of these handles (on the left and bottom of the cursor) are used to position
the color box. The other three handles (on the top and right of the cursor) are used to size
the color box.
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Moving and Sizing Background Color Boxes

Use the handle at the top of the cursor to adjust the height of the color box. Usethe
handle on the right side of the cursor to adjust the width of the color box. Dragging the
handle on the upper right corner of the cursor will adjust both the height and width of the
color box.

Y ou can move the Background Color Box in any direction by clicking on the handlein
the lower left corner of the cursor and dragging the mouse. If you want to move the color
box horizontally only (without moving it vertically) use the handle on the left side of the
cursor. The handle on the bottom of the cursor will move the color box vertically
(without changing the horizontal position).

Changing Background Color Box Color
There arefive different ways of selecting a color for the background color box. These
methods are as follows:

Color Picker
The color picker lets you select the color using a visual approach.

Color Sliders
The color dliderslet you select a color using a numerical approach.

Color Palette
The color palette lets you select a color from a palette of 64 (User Definable) preset
colors.

Color Gradient

A color can be selected from a group of 64 user-defined color gradients. These may
be either alinear gradient with up to 16 color points that can be rotated up to 90
degreesin either direction, or an area gradient that can have four or five color points
defined.

Color Texture
A color texture can be selected from any of the 16 textures that are currently loaded.
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Color Picker

Pressthe "Picker" button to display the color picker controls. The color picker controls

are shown below.

Eicker

Shderz

Palette

Gradient

Textures

W Top Colar

¥ Eottom Color

Legal Color

Pick Caolar
from Screen

Trans:

‘I_ﬂl

»l
Yideo:

The top and bottom of each background color box can be set to different colors. There
are two boxes to select whether we want to change the top color, the bottom color, or
both. If the top and bottom colors are different, the color box will be drawn with a
smooth color spread between the two colors. The top and bottom transparency and
background video levels can aso be set independently.

Below these check boxesis an lllegal Color Indicator. If the selected color exceeds
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

Below the lllegal Color Indicator isthe "Pick Color From Screen™ button. Pressing
this button will change the appearance of the mouse cursor to ook like an eye dropper.
Move the mouse to a position on the screen that you want to copy the color of, press left
mouse button and the color under the mouse will be selected.

To theright of these controlsisthe Hue Picker. Thisis used to select the hue (red,
green, blue, etc.) of the color. Place the mouse over this control, and press the left mouse
button to select the desired Hue. When the new hue is selected, the background box will
be redrawn with the new color, and the Color Picker Area (to the right of the Hue
Picker) will also be drawn with the new hue.

Once the hue is selected you can now pick acolor. Place the mouse over the Color
Picker Area and press the left mouse button. Thiswill select the color under the mouse.
If you hold down the left mouse button while you move the mouse around the Color
Picker Area, the background color box will be redrawn with the new color each time you
select anew color by moving the mouse.
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Y ou can also control the Transparency of the color. The Transparency setting can
make the color fully opague, semi-transparent, or fully transparent. When a color is semi-
transparent, the text component is drawn tinted over whatever isbehind it. When the
color isfully transparent, it can't even be seen on-screen. Setting the transparency level to
0 makes the object fully opague. Setting the level to full (255) makes the object fully
transparent. Any value in between, makes a color that is semi-transparent.

There are avariety of ways to change the Transparency level. Thelevel can be
increased by pressing the increase button to the right of the transparency number box. If
you hold this button down, the level will continue to increase until you release the button.
To decrease this value, press the decrease button. Holding down this button will continue
to decrease the value until it isreleased. If you move the mouse over the transparency
number box, then press and hold down the left mouse button, you can change the value by
moving the mouse. Moving the mouse up or to the right will increase the value. Moving
the mouse down or to the left will decrease the value. When you have selected the
desired value, release the left mouse button.

The value of the transparency level can be entered directly. Do this by double-clicking
the transparency number box (thiswill highlight all of the digitsin the number), typein
the new value and press the enter key.

The color can be also mixed with background video. Setting the video level to avalue of
0 makes the object the selected color. Setting the video level to full (255) draws the
object with background video. Any value in between makes the object appear as
background video that istinted by the selected color. For some very interesting effects,
try blending colors, background video, and transparency over a background graphic
image.

The background video level can be adjusted in the same way as the transparency level.
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Color Sliders
Pressthe "Sliders" button to display the Color Slider Controls. The Color Slider
Controls are shown below.

Picker
— 1 |¥ Top Calor Fied JI IEE
Gliders * RGE |
¥ Eottom Color T Green ] |15?
Palette ™ HLS
_— Bl —_— I
Gradient Legal Color b= J' 231

I | ——]

The top and bottom of each Background Color Box can be set to different colors. There
are two check boxes to select whether we want to change the Top Color, the Bottom
Color, or both the top and bottom colors. If the top and bottom colors are different, the
Background Color Box will be drawn with a smooth Color Spread between the two
colors.

Testures | Tranz.

Below these check boxesisthe lllegal Color Indicator. If the selected color exceeds the
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

The Power CG has two (2) numerical systemsfor defining colors. They are RGB (Red,
Green, Blue) and HLS (Hue, Luminance, Saturation). Both of these systems are used to
define the same thing (like yards and meters). Adjusting one will automatically change
the other. Y ou can select which method to use by pressing either the RGB or HLS button.
Y ou can switch back and forth between the 2 color systems at any time just by pressing
the approprate button.

The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking
the number box and entering the new value with the keyboard.
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Color Palette
Press the “Palette” button to display the color palette. The Color Palette is shown
below.

Ficker
¥ Top Colar
Shderz
¥ Eottom Color
Ealette
Gradiert Legal Color
Testures | Background Video Dauble Click an any Calar buttan ta madify it

The preset Color Palette can hold 64 preset colors. These preset colors are displayed in
thiswindow. Not all of the preset colors can be displayed at one time, so there is a scroll
bar on the right hand side of the color palette entries. Use this scroll bar to scroll through
all of the preset colors.

The top and bottom of each Background Color Box can be set to different colors. There
are two check boxes to select whether we want to change the Top Color, the Bottom
Color, or both the top and bottom colors. If the top and bottom colors are different, the
Background Color Box will be drawn with a smooth Color Spread between the two
colors.

Below these two check boxesisthe lllegal Color indicator. If the selected color exceeds
the NTSC or PAL limitations, this box will appear red to indicate that you have selected
anillegal color. Otherwise thisbox will appear green.

To select acolor from the preset color palette, position the mouse over the desired color
and click the left mouse button. Y ou can change acolor in the preset Color Palette by
double clicking the entry that you want to change. For more information about modifying
the preset Color Palette, see the section "Modifying the Color Palette™ in chapter 12.

Thiswindow also has a button labeled "Background Video". Pressing this button will
set the color so that the Background Color Box will be drawn with background video.
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Color Gradients
Press the "Gradient" button to display the color gradient selection window. The Color
Gradient selection window is shown below.

Picker

Shderz

Palette

[raniemt

Textures

64 color gradients can be created for each project. The Color Gradients that are currently
set are displayed in thiswindow. Not al of the color gradients can be displayed at one
time, so thereisascroll bar on the right hand side of the Color Gradient entries. Usethis
scroll bar to scroll through all of the color gradients currently set for the project.

To select acolor gradient, position the mouse over the desired gradient and click the left
mouse button. The Background Color Box will then be drawn with the selected color
gradient. You can edit a Color Gradient, or build a new one, with the gradient builder.
To do this, double-click the Color Gradient that you want to modify. For more
information about using the gradient builder, see the section "Building Color Gradients"
in chapter 12.
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Color Textures
Pressthe "Textures" button to display the Color Textures selection window. The Color
Textures selection window is shown below.

Picker %M%M%M%M%MELI
: .'_IEHMWﬁMﬁM%H

Shderz e EIEENE

ot IIII|=|I|||~|I|II~IIIII~|II|I~W_I

Gradiert | [ -

. = ——— —
. - — — -
i — — —_— —_—

Double Click on any Texture to mu:n:llf_l,l it.

I ==

16 full Color Textures can be loaded into the system at onetime. The Color Textures that
are currently loaded are displayed in thiswindow. The Textures are displayed large
enough so that you can easily see what the texture looks like. Not all 16 textures can be
displayed in thiswindow at one time, so thereisascroll bar on the right hand side of the
textures. Usethis scroll bar to scroll through all of the textures that are currently loaded.

To select a Color Texture, position the mouse over the desired texture and click the | eft
mouse button. The Background Color Box will then be drawn with the sel ected texture.

Y ou can load a new texture by a double-clicking on the one that you want to replace.
When thisis done you will be asked to specify which graphic image you want to load as a
texture. For more information about |oading graphic images as Color Textures, see the
section "Loading Textures" in Chapter 12.

Full-Screen Background Color

To create a background color box that covers the full-screen, press the "Full Screen
Background Color" button. A new background color box (that is a semi transparent
gray) will be created that covers the entire page.

Selecting Background Color Box

Y ou can only edit one background color box at atime. Before you can modify a
background color box you need to select it. The selected color box is displayed with a
cursor (rectangular box) around it. The cursor also has six small boxes attached to it.
These are called cursor handles, they are used to size and position the background color
box.

Background color boxes can be selected by clicking the mouse on the desired one. |If

more than one background color box overlap, keep clicking the left mouse button until
the one you want is sel ected.
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Changing Color Box Priority

Each color background box is placed on its own separate layer (behind the text layers and
in front of the background graphic image). The priority of each background color box
determines how it will appear when one color box is overlapped by another. The
background color boxes that have a higher priority will appear in front of color boxes that
have alower priority.

The background color controls have four buttons that are used to change the priority of
the background color boxes. These buttons allow you to move the background color
boxesin front of, or behind other color boxes when they overlap. These buttons are
shown below.

Press this button to move the current background color box to the highest
priority. When thisisdoneit will appear in front of al other background
color boxes.

Press this button to increase the priority of the current background color
box by one. Thiswill place the color box in front of the color box that
had the next higher level of priority (if they overlap).

Press this button to decrease the priority of the current background color
box by one. Thiswill place the color box behind the color box that had
the next lower level of priority (if they overlap).

Press this button to move the current background color box to the lowest
priority. When thisisdoneit will appear behind all of the other
background color of boxes.

RaE T

Converting a Background Color Box to a Shape

A background color box can be converted to a shape by pressing the "Convert Color
Box to Shape" button. When thisis done the color box is placed in front of all the other
background color boxes. Once a background color box has been converted to a shape, it
cannot be converted back to a Background Color Box.

When a background color box is made into a shape, it can be italicized, rotated, and
rounded just like any other shape. It can aso have edges and shadows added to it just like
any other character.

Deleting a Background Color Box

To remove a background color box from the page, select the background color box that
you want to delete by positioning the mouse over it and clicking the left mouse button.
Onceit is selected, press the "Delete Background Color Box" button. Thiswill delete
the current background color box.
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Chapter 10
Background I mages

The program can display either a graphic image or a background video source (provided
your system is capable of overlying titles over video) behind the text. The background
graphic can be in any of the following graphic formats:

Windows bitmap (BMP)
TIFF

Targa (TGA)

PCX

GIF

These are standard graphic formats that can be generated by many third party software
packages. If no background graphic image is selected, the text will be overlaid over the
background video source (if your system is capable of this).

A background graphic can be displayed in either original size, scaled to fill the entire
screen, or tiled to fill the screen. When the graphic is displayed with its original size, it
may or may not fill the entire screen. When agraphic is displayed full-screen, it is scaled
(either up or down) to match the screen dimensions. When the graphic istiled, it is
displayed initsoriginal size and is repeated enough times to fill the entire screen.

To change the background image, select the "Background - Image" tab In the Control
Tabs window. The Background Image Controls (shown below) will be displayed.

Character I Edges | Shadows | Colors Layers I Pozitioning | Fiow Spacing I Shapes I
Logog Background - Image B ackaground - Colors | Fage Transitions
— Backaground Graphic Fasition
Mo Graphic -

(e Graphic - Original Size

Graphic - Full Screen Graphic: - Tiled | | |

JE: WPOWERCGMBITMAPYShagala. bmp
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No Graphic (Background Video)

Specia hardware or software (if the program is running asaplug in) is required to
overlay the titles over video. Some systems are not capable of this. If your system is not
capable of overlaying titles over video, the background will be displayed as black.

To overlay the title over background video, pressthe "No Graphic (Background
Video)" button. Any background graphic that may have been displayed will disappear
and the text will be displayed over the background video.

Graphic - Original Size

When you load a graphic to be displayed in its original size, the graphic may be smaller
than the screen, the same size as the screen, or larger than the screen. To load a graphic
initsoriginal size, press the "Graphic-Original Size" button. A window will appear
asking you to Select the Background Graphic. Select the graphic image that you want to
load as a background and press the "Open" button. The selected graphic will be loaded.

If the graphic is smaller than the screen, it will be centered on the screen, and the
positioning buttons that are used to change graphic position will be displayed.

If the graphic is the same size as the screen, it will be displayed as afull-screen image. If
the graphic is larger than screen, a warning message (like the one shown below) will

appear.

Warning |

Graphic iz larger than screen
Do you want to scale the Graphic?

At this point you have the option of shrinking the graphic so that the entire image will fit
on the screen, or displaying the graphic in its original size and cutting off the outside
edges of the graphic. To display the graphic without shrinking it, press the "No" button.
The new graphic will then loaded as the background.

To shrink the background graphic so that all of it will be displayed, pressthe"Yes"

button. Thiswill load the graphic "Full-Screen". See the section below (Graphic-Full
Screen) for more information.
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Graphic - Full Screen

When you load a graphic to be displayed full-screen, and the original size of the graphic
is not the same as screen dimensions, the graphic must be scaled before it will fit the
screen. If the graphic is smaller than the screen, it will be enlarged. If the graphicis
larger than the screen, it will be reduced in size.

A video screen has afixed aspect ratio of 4 by 3. This means that the screen is one-third
wider than it istall. If the background graphic image has a different aspect ratio (maybe
it'staller than it iswide), the height and the width will need to be scaled by different
amounts to make the image fill the entire screen. This can distort theimage. It can make
people look very fat, or very tall.

Before the background image is loaded full-screen the aspect ratio of the graphicis
checked to see if it matches the screens aspect ratio. |If the aspect ratios are different, a
warning message (like the one shown below) is displayed.
Warning |
@ Graphic does nat have the same
azpect ratio az the zcreen

Do pou want ko Prezerve the Azpect B atio?

If you choose to preserve the aspect ratio, the background graphic will be scaled
horizontally and vertically by the same amount. Thiswill prevent the image from being
distorted. However the graphic will not fill the screen both horizontally and verticaly. If
the imageistoo tall, it will not fill the screen horizontally. If theimageistoo wide, it
will not fill the screen vertically.

If you choose not to preserve the aspect ratio, the background image will be scaled
horizontally and vertically the amount necessary to fill the entire screen. If thisresultsin
unacceptable distortion, ssimply load the background graphic again, and this time preserve
the aspect ratio.
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Graphic - Tiled

If agraphic image is smaller than the screen, it can betiled in the background. Thiswill
display the background graphicinits original size. The graphic will be repeated
horizontally and vertically to fill the entire screen.

To tile abackground graphic, press the "Graphic - Tiled" button. A window will appear
asking you to select the background graphic. Select the graphic image that you want to
load as a background and press the "Open" button. The selected graphic will be loaded
and tiled.

If the graphic islarger than the screen, a warning message (like the one shown below)
will appear.

Warning |

Graphic iz larger than screen
Do you want to scale the Graphic?

At this point you have the option of shrinking the graphic so that the entire image will fit
on the screen, or displaying the graphic in its original size and cutting off the outside
edges of the graphic. To display the graphic without shrinking it, press the "No" button.
The graphic will then be loaded as the background. Portions of the graphic image will be
cut off.

84



Chapter 11
Projects and Pages

Project Settings

Projects are a convenient way of keeping groups of pages and project settings separate
from each other. When anew project is created Power CG creates a new folder (with the
same name as the project) on your system. Whenever you are working in this project, the
pages will be read from and written to this folder asthe default. All pagesthat arein this
folder will appear in the Project Manager window.

The system default settings are saved in the project file. Thisfile has the same name as
the project with a.SET extension (for example, the project MY _PROJECT would be

defined in afile called MY_PROJECT.SET). Thisfile contains the following system

default settings:

Character Attributes
Style Gallery

Color Gradients

Default Color Palette
Loaded Typefaces

L oaded Textures

Default Directory/Folders
Safetitle Margins

Tab Settings

When anew project is created, the current system settings are saved as the Project
Defaults. When the project is opened again, these settings will be restored as the default
settings.

Y ou can update the default settings of the project by selecting the "Save Project
Settings" command in the "File" menu. The current systems settings will be saved as the
Project Defaults.

When you exit the program, or you open another project, a message appears (see below)
asking you if you want to save the current settings.

Power CG |

@ Do you want to save the curent zettings?

MHa | Cancel |
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If you pressthe"Yes" button, the project settings will be updated to match the current
Settings.

Project Manager
The Project Manager is used to give you quick accessto al the pagesin the project.
Thiswindow (shown below) is on the |eft hand side of the screen.

Show_off
blktrnz1 edif

Al 2
Tl

- Frawds Ly

=
B eit7 8

86



All of the pages in the current project are displayed in thiswindow. The pages are
represented both by PICON’ s and the name of the pages. A PICON (Picture ICON) isa
miniature picture of the page. With PICON's you can tell at a glance what the page looks
like. Y ou can open any page in the project just by clicking on it in the Project Manager
window. If there are too many pages in the project to be displayed at one time, you can
scroll through the list of pages using the Project Managers scroll bar.

Pages can be created, opened, saved, copied, deleted, and exported from the menu that
appears when you position the mouse over the project manager and click the right mouse
button. This menu is shown below.

MHew Page Chrl+k
M ew Still Page

MHew Boll Fags

Mew Crawl Page

Open Page... Chrl+0
Save Page Clrl+5
Save Page Az

Delete Page

Expart Title Graphic

MHew Praject...
Open Project...
Save Project Settings

This menu also has commands for creating a New Project, Opening an existing Project,
and Saving the current settings as the Project default Settings. These menu commands can
also be selected from the "File” menu.

Pages

When pages are saved on the disk, they are each saved in a separate file. The sizes of
these files are determined by the amount of text and the complexity of the page. Most
pages are smaller than 1 or 2 Kbytes unless they contain logos or textures. Hundreds of
pages can be stored on a floppy disk and tens of thousands can be stored on a hard disk.
Each page file can be given aunique name. The“.PAG” extension is added to the page
name to create the file name that the page will be stored under.

The pages are stored in aformat that allows them to be fully edited, even after they are
saved. You don't need to worry about things getting “locked down” after the page has
been saved. The pages can also be saved in both Windows Bitmap (BMP) and Targa
(TGA) formats. Thisletsyou use the Title Graphics that you create in other graphics
programs. Saving the page as one of these graphics formats automatically savesit in the
Page (PAG) format aswell. This keeps the pagein aformat that can still be edited (Have
you ever tried to correct the spelling of aword in a Bitmap?).
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All information needed to display the page is stored in the page file except for the
Typefaces and the background graphic. When a page has a Logo or multiple Logos on it,
the logo is stored in the page file. Thisisdone to speed up the Page Recall time. The
page file does keep track of which background graphic and typefaces are used in the page.
When a page isrecalled, the system will automatically load the needed typefaces and the
background image.

When a page is saved or recalled, the dialog box first displays with the default page
directory. You can select another directory to save the page to or recall it from.

The default page directory can be changed. See the section “Default Directories” in
Chapter 12 for more information on how to do this.

Creating a New Page
To create anew page, use one of the following commands:

Pressthe “New Page” button on the Toolbar.

Select the “New Page” entry from the “File” menu.

Select the “New Still Page” entry from the “File” menu.
Select the “New Roll Page” entry from the “File” menu.
Select the “New Crawl Page” entry from the “File” menu.
Press and hold down the <Ctrl> key while pressing the <N> key.

When thisis done the process of creating a new page will begin. If the “ Automatically
Save Pages’ setting in the “User Preferences’ dialog box requiresit, the following
message box will appear.

Automatically Save Pages |

Do you want o zave
the changes to the
curent page?

Mo |

[f you don't want the zpztem to keep
azking pou this question, uze the
"Uzer Preferencesz" command in the
"Setup” menu to chanage the
“futomatically Save Pages" zettings.

The system can only have one page opened at atime. When you open a new page, the old
page (or any changes madeto it) will be discarded unlessit is saved to the disk. If you
want to save the changes to the old, page press <Yes>, otherwise press <No> and the
changes will be discarded.
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If the page was not saved, the following warning will appear:

Mew Page |

@ Thiz will eraze the current page.

Are pou sure you want to do thiz?

If you do not want to lose the changes to the current page, press the “No” button to cancel
the New Page operation. Y ou can then save the old page.

If you pressthe “Yes” button, all of the text and background will be erased from the
screen. If you did not use a command that specified the page type, the “Select the
Page Type” dialog box (shown below) will appear.

Select the Page Type

Rol | Cawl |

Select the type of page that you want to create.

Select the Page type dialog box

Use this box to select which type of page you want to create. This gives you afresh page
to start with.
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Opening an Existing Page
Opening a new page will overwrite the page that is currently open. Make sure that you
save any changes to the current page that you want to keep before opening a new one.

To open an existing page, use one of the following commands:

Select it from the listed pages in the Project Manager window.
Select the “Open Page” entry from the “File” menu.

Pressthe “Open Page” button in the Toolbar.

Press and hold down the <Ctrl> key while pressing the <O> key.

If the “Automatically Save Pages” setting in the “User Preferences” dialog box
requiresit, the following message box will appear.

Automatically Save Pages |

Do you want to zave
the changes to the
current page?

Mo |

If you don't want the zyztem to keep
asking you thiz queszhion, use the
“Uzer Preferences™ command in the
“Setup” menu to change the
“Automatically Save Pages" zettings.

The system can only have one page opened at atime. When you open a new page, the old
page (or any changes madeto it) will be discarded unlessit is saved to the disk. If you
want to save the changes to the old page press “ Yes”, otherwise press“No” and the
changes will be discarded.
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Once this is done the Open Page dialog box (shown below) will appear.

Open Page H |
Lookin: |23 Pages = =N
|1 Marianne Arch.pag Big_co.pag charriz. pac
|1 weboard Biaw_poo.pag broadwan. A Cloudsz. pat
Atodd. pag bad_rall.pag Co.pag Cooper.pa

Ajrtest pag Bball. pag Cg_logo.pag Crazy.pag
Alazka.pag Bears.pag Co_logal.pag Cralderna.
Alladin.pag Big.pag Cg_tile.pag Cute.pag

« | i

Flegame: | | Oeen |
Files of type:  [Pages [+ PAG) =] Cancel |

Open Page dialog box

Use this dialog box to select which page to open. Once a page is opened it will appear in
the “Title Compose” window. Y ou can now edit the page.

Saving a Page

When you are finished editing a page, you need to saveit to the disk. To do this, select
the “Save Page” entry from the “File” menu (or pressthe “Save Page” button on the
Toolbar). If the page already has a name, it will be saved back to the disk under the old
name. If the page does not yet have a name, the Save Page As dialog box will appear (see
Saving a Page with a New Name) so that you can name the page.

Every oncein awhile, while editing a page you should save it to disk. This protects your

work from things like power failures. This function can be accomplished by holding
down the <Ctrl> key and pressing <S>.
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Saving a Page with a New Name

To save a page with anew page name, select the “Save Page As” entry from the “File”
menu.

When thisis done, the Save Page As dialog box (shown below) will appear.

Save Page As

Savejn: |zl Pages =| £ i
|1 Marianne Arch.pag Big_co.pag charriz. pac
|1 weboard Biaw_poo.pag broadwan. A Cloudsz. pat
Atodd. pag bad_rall.pag Co.pag Cooper.pa

Ajrtest pag Bball. pag Cg_logo.pag Crazy.pag
Alazka.pag Bears.pag Co_logal.pag Cralderna.
Alladin.pag Big.pag Cg_tile.pag Cute.pag

« | i

File narme; I Save I
Save as type: IF'ages [ PAG] j Cancel |

Save Page As dialog box

Use this dialog box to select aname for the page. The “Save as type” control alows
you to select which format you would like to save the page as. This can be any of the
following:

Page (*.PAG)
Windows Bitmap (*.BMP)
Targaformat (*.TGA)

Some systems may aso have other formats to choose from.

If you save the page as either a Windows Bitmap or Targa format file the image can be
used by other graphics programs. Since text stored in these formats cannot be edited
(without a great deal of difficulty), the page will also be saved in the “ Page (* .PAG)”
format. This keepsthe page in aformat that you can edit.

If the page is saved under a new name, the old page will remain on the disk under the old
page name.
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Deleting a Page from the Disk

Before you can delete a page from the disk you must use the Open Page function to recall
the page to the screen. Thisforcesyou to “look at it” to make sure it’ s the right page
before you delete it. Once the page has been opened, select the “Delete Page” entry
from the “File” menu. A warning such as the one below will appear.

Delete Page |
Thiz will delete the cunrent page:
DeALISANPAGE Shurwanted. PAG
from the disk.

Are pou sure you want to do thiz?

The second line in the warning box shows the directory and page name of the page about
to be deleted. If you don’'t want to delete this page, press the “No” Button. Pressing the
“Yes” button will delete the page from the disk. Once thisis done you will not be ableto
open the page again.

Export Page

Many systems like to see the title pages exported in a particular graphics format. 1n most
instances, thisisthe TGA format (the Video Machine version exportsin the VM format).
The new image will have the same name as the page you are editing. For example: if the
page is saved under the name "MY .PAG", the Targa image would be saved as
"MY.TGA".

Each model of the software exports pages in the graphics format that is most useful for
the system you are running Power CG with (usually TGA). To export a page, press the
"Export Page" button in the shortcut buttons window. The page must be named before
it can be exported. If the page is not named, a message (like the one below) will appear
to remind you to give the page aname. Once the page is named, you can then export it.

Motice

Fage Must be zaved before it can be exported
Try File | Save Page Az,

Cancel |

If you press the “OK” button the “ Save Page As” dialog box will appear to allow you to
give the page aname.
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The page can also be exported by selecting the "Export Title Graphic" command from
the "File" or "Project Manager" menus.

Creating a New Project

When anew project is created, the current systems settings are saved as the new project
defaults. So, before you create a new project, you should open an existing project that
has systems settings similar to the default system settings that you want the new project to
have.

To create anew project, select the "New Project” command from the "File" or “Project
Manager” menu's. When thisis done awindow (like the one shown below) is displayed.

Create a New Project |

Mew Project Hame:

Create I Cancel

Enter the name of the new project where it says "New Project Name" and press the
"Create" button. The name of the new project now appears at the top of the project
manager. Since we haven't created any pages for the new project yet, no pages appear in
thelist. Asyou create pages for this new project they will appear in the Project Manager
window.
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Open an Existing Project

To open aproject that already exists, select the "Open Project”" command from the
"File" or Project Manager menus. Once thisis done the "Load New Project Settings"
window (shown below) will appear.

Lood now Projct Sotngs IR
Lookin: | 2l Powercg = ==

Bitmap i Show_off SET
Gif

Prou

Praojects

Typeface

Drefault. zet

File name: Open I
Files of type: [ Setups (*SET) =l Cancel |

Use this window to select which project to open and press the "Open” button. When the
new project is opened, the new projects system settings will be loaded. The old project
settings will be overwritten. Before the old project settings are lost, you'll be given the
chance to save them. The following window appears.

Power CG |

@ Do you want to save the curent zettings?

MHa | Cancel |

Y ou can save the old system settings to the old project file by pressing the "Yes" button.
Pressing the "No" button will open the new project without saving the system settings. If
you change your mind about opening the new project (or selected the Open Project
command by mistake) press the "Cancel" button and the new project will not be opened.

Once the new project is opened, the pages in the project will appear in the Project
Manager window.
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Save Project Settings

To save the current settings as the project defaults, select the “ Save Project Settings”
command from the “File” or Project Manager menus. The current project settings will be
restored the next time this project is opened.
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Chapter 12
M odes, Settings, and Adjustments

User Preferences

The" Set User Preferences" dialog box is used to set preferences that may vary from
one user to another. To change the user preferences select the "User Preferences”
command from the "Settings" menu. When thisis done the "Set User Preferences"
dialog box (such as the one shown below) will appear.

Set User Preferences E
— Image Rezolution — TupetacesLogo,/Texture Memaory: — Automatically Save Pages
Herizartal [540 800 Max |4_ MBytes ™ Always Automatically 5 ave
ertical [430 GO0 Max _ bin 1 - MEIH-3-2. " Always Ask First

. _ Thiz walue specifies how much i Mever Automatically Save

Theze changez will not be effective memany to aszigh to the Tppefaces, : :
bl the newt time pou start Power CG. Logos, and Testures buffer. |f wou

These values define the dimensions i getting an emor meszage of Ok I Cancel
Typeface/Logo/Texture b emary

of the Text Images you want to
create. Theze zhould be =&t o the
values required by pour display card.

Full* pou zhould increaze this value.

The set user preferences dialog box is made up of the following controls.

Automatic Page Save mode Used to select the Automatic Page Save mode.
Typeface/Logo/Texture Memory Used to set how much memory to use for the
setting Typeface, Logos, and Textures buffer.

Other Preferences Other preferences that are unique to the type of

hardware you are running the program with.

Automatic Page Save Mode

The program can only have one page open at atime. When you open a new page, the old
page (or any changes made to it) will be discarded unlessit is saved to disk. When you
open anew page, or exit the program, the current page can automatically be saved to disk
if it was changed.
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Always Automatically Save

This setting will automatically save the page to disk (overwriting the original) without
prompting you. Use this setting with caution. Any changes you make to the page will
be saved to disk. You don't have the option of changing your mind.

Always Ask First
This setting will ask your permission before saving the page to disk. If you have not
modified the page, you will not be asked if you want to saveit.

Never Automatically Save
This setting will never automatically save the page. The program will not display the
"Automatically Save Pages" window when you open a hew page.

Typeface/Logo/Texture Memory Setting

When the program starts, it allocates a block of memory that is used to hold Typefaces,
Logos, and Textures. Thismemory is aso used to cache data that is needed temporarily
when composing pages. If you allocate more memory for this, you will be able to load
more and bigger Typefaces, Logos, and Textures. You will also get better performance
from the program, but less memory will be available for other applications.

If you are getting an error message such as " Typeface/Logo/Texture Memory full" you
should increase this value.

Other Preferences

This box may also have other user preference settings that are unique to the type of
hardware or software you are running the program with.
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Setting up Tabs

The program can set up to 16 tabs per page. The tabs specify horizontal positions of the
screen that are used to align columnar text. The tab positions are stored with the page.
When a page is opened, the tab positions will be set to those that the page was created
with.

To add, remove, or reposition atab, or to enable or disable the tab display, select the "Set

Up Tabs" command from the "Settings" menu. Thiswill display the “Set Up Tabs”
dialog box (shown below).

SET UP TAES
Tozet a MEW TAR, select the tab position,
[ Display Tab Positions gEsa Se LI el
To MOVE & TAB, drag it to the desired position.
ToDELETE & TAB, select it and press the Delete T ab button
Delete Tab Cancel |

Display Tab Positions

The Tab Display shows the positions of the tabs that are currently set. If thetab display is
enabled, vertical lineswill appear the full height of the screen. Each one of these vertical
lines shows the position of atab that is currently set. Clicking the "Display Tab
Positions" check box will toggle the state of the Tab Display. If the Tab Display ison
(signified by a check mark), thiswill turn it off.

Markersin the set up tabswindow (below the title compose window) aso shows the
current tab positions. These markers are displayed regardiess of the "Display Tab
Positions" setting. Let's call thiswindow the "Tab Markers Window".

Once the tabs have been set up, they can be saved as the default tab settingsin a project.

Set a New Tab

The Tab Markers window displays al of the tabs that are currently set. To set anew tab,
position the mouse in the Tab Markers window at the position that you want the new tab
and click the left mouse button. A new marker will appear at the mouse position to
indicate the position of the new tab.

99



Move a Tab

To move (reposition) an existing tab, position the mouse over the Marker that you want to
move and drag it to the desired position. Any text that is on the page will be redrawn to
reflect the new tab position.

Delete a Tab

To delete an existing tab, select the marker that you want to delete by moving the mouse
over it and pressing the left mouse button. The marker will turn red to indicate that it is
selected. Pressthe "Delete Tab" button. The selected marker will be deleted.

Safetitle Margins

When transmitting a video signal to alarge number of televisions, many of those
televisions will not be properly adjusted. If you create afull page of text and try to view
it on one of these televisions, the text may be cut off on the left, right, top, or bottom of
the screen. When you broadcast text, you normally want everyone to be able to read it
(especidly if you are trying to sell them anew TV).

To solve this problem we define marginsthat it is safe to title within. The margins are set
by the factory to be at the recommended 10% height and width positions of the screen.

Y ou can change these margin positions. To do this select the "Safetitle Margins”
command from the "Settings" menu. When this is done the safetitle margins dialog box
(shown below) will appear.

Safetitle Marginz E
Top Margin Left kargin Right k4 argin Bottom bargin
[ Display 5 afetitle M arginz
‘ IEd IE?E ‘
|48 — 432 Dione

Default | v ‘ ‘ b

Use the "Display Safetitle Margins" check box to hide or display the safetitle margins
on the screen. The safetitle margins are displayed on the screen whenever the " Safetitle
Margins" window is displayed, regardless of the state of the "Display Safetitle
Margins" check box.
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If you keep your text within this box it will be in the safetitle area. Use the arrow buttons
to move the safetitle margins. Each margin (top, bottom, left, and right) has two buttons
that are used to move them.

‘ Moves the margin up one scanline. ‘ Moves the margin |eft one pixel.

v Moves the margin down one scanline. ’ Moves the margin right one pixel.
Y ou can aso set the margin positions by entering a value directly.

To set the margins to the recommended 10 percent height and width positions of the
screen, press the "Default” button.

Once the safetitle margins are adjusted, pressthe “Done” button. Thiswill remove the
dialog box from screen. The safetitle settings are saved as one of the project settings.

Lower Third Mode

Quite often with titling an image, you want to keep the titles in the Lower Third position
of the screen. To do this, without needing to re-position every page, set the system to
Lower Third mode. This moves the top margin (as well as the page text) to the Lower
Third position. Any pages composed in this mode will appear in the Lower Third portion
of the screen. Centering a page in thismode will center it in the Lower Third area.

To change the Lower Third mode select the "Lower Third Mode" command from the
"Settings" menu. If the system is aready in Lower Third mode, the Lower Third mode
will be turned off. Y ou can also toggle the Lower Third mode by holding down the
<Ctrl> key while pressing the <T> key.

The current lower third mode can be saved as one of the default project settings.
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Default Directories

The program allows you to put any file in any directory on any disk. This often resultsin
filesthat you can never find again. It isbest to keep files of the same type (or the same
project) in the same directory. Default directories are abig help here. The system allows
you to set default directories for the different file types. The default directories, and the
type of filesthat default to these directories, are shown below.

1. Page Directory

Pages
Page Lists

2. Exported Graphics
Graphic images that are exported when you press the "Export Page" button.

3. Typeface Directory
Typefaces
Logos
Textures

4. PCX Image Directory
PCX format background images.

5. GIF Image Directory
GIF format background images.

6. Bitmap (BMP) Image Directory
Windows bitmap (BMP) format background images.

7. Targa (TGA) Image Directory
Targa (TGA) format background images.

8. TIFF Image Directory
TIFF format background images.
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To change the default directories, select the "Default Directories” command from the
"Settings” menu. When thisis done the “Default Directories” Dialog box (shown
below) will appear.

Default Directones |

(BBl PO ERCGLWPROJECTSVSHOW OFF Browse. ..

Exported Graphics: [\POWERCG\PROJECTS\SHOW_OFF Braowse. .
Typefaces: [\POWERCGATVPEFACE Browse | | Ok |

P [\POWERCGLPCH Browse...
GIF: [\POWERCG\GIF Browse.. Lancel |

Bitmap [BMP}: [\POWERCG \BITMAR Browse...

Targa (TGA) [\POWERCGTARGA Braowse. .

TIFF: [\POWERCGATIFF Braowse. .

This dialog box displays the default directories and their current settings. The path can be
entered directly, or you can browse for the desired directory.

To enter apath directly, select the default directory entry that you want to change, and
typein the full drive and path. This should be in aform such as C:\PATH. When you
directly enter adefault directory, you must make sure that the path exists on the specified
drive.

To browse for the desired directory, press the "Browse" button next to the directory that
you want to change. When thisis done the “ Select Directory” dialog box (shown
below) will appear.

Select Directory E |
=C: Current Directary:
[F=POWERLCG CAPOWERCESPROJECTSASHOW _OFF
[F=PROJECTS .
@ SHOW_OFF Driyes:

= j
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Use this dialog box to select the new default directory. The controlsin this dialog box do
the following:

Directories List

Use this control to select the default directory.

Drives

Selects the drive that contains the desired default directory.
OK button

Press this button when the directory is selected.

Cancel button

Press this button to cancel the directory selection.

When you are done selecting the default directories, press the "OK" button in the default
directories dialog box. If you want to cancel the changes you have made, press the
"Cancel" button.

Once the new default directories are selected they must be saved as the project settings.
Otherwise, they will revert to the old settings when the project is opened again.
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Modifying the Color Palette

To modify the color palette, the color palette must be displayed. Y ou can display the color
palette by selecting the "Colors" tab in the Control Tabs Window and then pressing the
"Palette" button. Position the mouse over the color palette entry that you want to change
and double-click the left mouse button. When thisis done the "Color Palette Editor"
window (shown below) will be displayed.

Color Palette E ditor E

Red J— |224 ﬁ Hue '—JI 28 ﬁ

Green JI |159 ﬁ Luma Jl 100 ﬁ

El | M ga | —— .l

e N 100 A a J— 204 M

1 1
Tranz. | _| I':I ﬁ Yidea | _| I':I ﬁ
..................... EI K Legal Calor Transparent | Eackground Viden E.I:.Crl; SE;IELH

The color palette editor has two methods of selecting acolor. You can use either the
Color Picker or the Color Sliders. The left side of this window shows alarge sample of
the current color selection. To the right of the color sample, at the bottom of the window,
isan lllegal Color Indicator. If the selected color exceeds NTSC or PAL limitations,
thisindicator will appear red to indicate that you have selected anillegal color.
Otherwise thisindicator will appear green.

At the top of the screen, between the Color Sample and the Color Palette, are the Color
Picker controls. These controlsinclude a"Hue Picker" and a"Color Picker Area".
The hue picker lets you select the hue (Red, Green, Blue, etc.) of the color. Place the
mouse over this control, and press the left mouse button to select the desired hue. When
the new hueis selected, the Color Sample, Color Picker Area, and the Color Sliders
will be updated to reflect the new hue.
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Once the hue is selected you can now pick the color. Place the mouse over the Color
Picker Area and press the left mouse button. Thiswill select the color under the mouse.
If you hold down the left mouse button while the mouse is moved, the Color Sample
and the Color Sliders will be updated to reflect the newly selected color.

Below the Color Picker Controls and the Color Palette Display are the Color Sliders.
There are two numerical systems for defining colors. These are RGB (Red, Green, Blue),
and HL S (Hue, Luminance, Saturation). Both of these systems are used to define the
same thing (like yards and meters). Adjusting one will automatically change the other.

Y ou can use either set of didersto adjust the color. When you use one set of didersto
change the color, the other set is automatically updated to reflect the change.

There are four ways to adjust the RGB, HLS, Transparency, and Background Video
levels. They can be adjusted by dragging the diders. They can also be adjusted by
double-clicking the number box and entering the new value with the keyboard. To "fine
tune" the levels, use the increment and decrement buttons. The value will be increased or
decreased by one each time you press one of these buttons. These buttons will auto-
repeat if you hold them down. The values may aso be changed by clicking in the number
box and dragging the mouse.

To theright of the Illegal Color Indicator isa"Transparent” button. Pressing this button
will set the transparency level to full (255). This makes the color fully transparent.
Anything that you assign this color to will not be visible.

To theright of the "Transparent” button isa"Background Video" button. Pressing
this button will set the background video level to full (255). Anything that you assign this
color to will be displayed using background video.

To theright of the "Background Video" buttonisa"Pick Color From Screen" button.
Pressing this button will change the mouse cursor to look like an eye dropper. Move the
mouse to the position of the screen that you want to copy the color of, and press the left
mouse button. The color under the mouse will be selected.

When you have selected the desired color for the color palette entry, you can select
another color to modify from the color palette. When you are done modifying the color
palette, pressthe "OK" button and the Color Palette Editor window will close.

Once the color palette has been modified, the changes must be saved with the project
settings. Otherwise, they will revert to the old settings when the project is opened again.
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Loading Textures

The system has 16 dlots that textures can be loaded into. When you use atexture on a
page, the page keeps track of which textures are needed to display the page. If the
textures that are loaded do not match the textures needed by the page, the correct textures
are automatically loaded.

To load anew texture, the texture selection window must be displayed. Y ou can display
the textures selection window by selecting the "Colors" tabs from the Control Tabs
Window and then pressing the "Textures" button. Position the mouse over the texture
entry that you want to load the new texture into and double-click the left mouse button.
When thisis done the "Select Graphic Image to use as a Texture" window (shown
below) will be displayed.

Select Graphic Image to use az a Texture

Laoak jn: I £5] Powercq

Bitrmap
Gif

Prou
Projects
Typeface

File narme; || Open I
Files of type: Iﬂll Image Types j Cancel |

[ Open az read-only

Select the graphic image that you want to load as a texture and press the "Open” button.
The selected image will then be loaded as a texture.

107



Building Color Gradients

64 color gradients can be defined for each project. To modify a color gradient, the color
gradient selection window must be displayed. Y ou can display the color gradient
selection window by selecting the "Colors" tab from the Control Tabs Window and then
pressing the "Gradient" button. Position the mouse over the gradient that you want to
modify and double-click the left mouse button. When thisis done the color gradient
builder (shown below) will be displayed.

Color Gradient Builder

Linear Gradient IArea Gradientl r a
I ‘ hd|
= [ze0
Red Hue J 0 ).
al I i
Green J— I » Luma | v ). 1]
Bl J— I Al Sat | —MM I— Al
g i} = al 170 =
Trans. | ID ;I WVideo | ID ;I

Legal Calar Tranzparent | Background Wideo EiDCnI: ch'[lg;n

Cancel |

The color gradient builder has two major sections, the Color Selection section (on the
right) and the Color Point Placement and Selection section (on the left). The Color
Selection section is used to select the color of each point in the color gradient. The Color
Point Placement and Selection section is used to select which point that you want to

change the color of, and to change the position of the color points that make up the
Gradient.

The program can create two types of color gradients, Linear Gradients and Area
Gradients. A Linear Gradient can have as many as 16 color points and can be rotated up
to 90 degreesin either direction. An Area Gradient can have either four (4) or five (5)
color points. A four point color gradient lets you define a different color in each corner
of therectangle. A five point color gradient also lets you add a 5th color point inside the
Area Gradient. The 5th color point can be moved to any position inside the gradient.
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The color point placement and selection section has two tabs. Oneto edit Area Gradients
and the other to edit Linear Gradients. When the color gradient builder isfirst opened,
the tab that corresponds to the type of gradient that you are editing is selected. To change
the color gradient to the other type just select the other tab.

Area Gradients
The “Area Gradient” tab (shown below) is used to edit area color gradients.

Spread Type— Corners
4 Paint Upper Left  Upper Right
v r
= & Paint
-
Apply Col
pp -ltr::u olor - -
zelected cormers Lower Left  Lower Right

The top portion of this window displays the current color gradient. If it isafive point
color gradient, two markers will appear. One above the gradient and one to the left of the
gradient. Theseindicate the position of the fifth point inside the gradient. Y ou can move
the inside color point by dragging these markers. Y ou can aso moved the inside color
point by clicking at the desired position in the color gradient in this window.

The Corners group is used to select the color point(s) of the Area Gradient that you want
to change the colors of. If the color gradient isa4 Point Area Gradient, four check boxes
will be displayed representing each corner of the gradient. If the color gradient isafive
point Area Gradient, an extra check box will appear which represents the inside color
point. When a color point is selected, the box is marked. Y ou can select more than one
color point to be changed. When you select a different color (in the color selection
section) all of the selected points will be set to the new color.
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There are two buttons in the Spread Type Group that let you select whether thiswill be a
4 Point or a5 Point color gradient. If you select " 5 point”, the positioning markers will
appear. A center check box in the corners group will also appear.

The"Apply Color to Selected Corners" button will set al of the selected color points
to the current color.

Linear Gradients
The Linear Gradient tab (shown below) is used to edit Linear Color Gradients.

Linear Gradient | Area Gradient I

The Linear Gradient tab has three main controls. The control on the left (let’s call it the
Placement Control) displays the current position and color of each point on the Linear
Gradient. Thetop control displays the current Linear Color Gradient. The bottom
control (let’s call it the Angle Control) is used to set the angle of the Linear Color
Gradient.

The Placement Control shows positions and colors of the color points that are currently
set. Each color point is represented by a marker on the left side of the Placement Control.
Y ou can use this control to add a new color point, move an existing color point, delete a
color point, or to select a color point to change the color of.
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Set a New Color Point

To set anew color point, position the mouse over the Placement Control where you want
the new color point to be and press the left mouse button. A new marker will appear at
the mouse position to indicate the new color point.

Move a Color Point
To move (reposition) an existing color point, position the mouse over the marker that you
want to move and drag it to the desired position.

Delete a Color Point

To delete an existing color point, select the marker that you want to delete by moving the
mouse over it and pressing the left mouse button. The marker will turn red to indicate
that it is selected, al other non-selected markers will be blue. Pressthe <Del> key on the
keyboard, and the selected marker (and color point) will be deleted.

Change the Color of a Color Point

To change the color of acolor point, select the color point that you want to change the
color of, by moving the mouse over its' marker and pressing the left mouse button. The
marker will turn red to indicate that it is selected. Use the controlsin the Color Selection
section (on the right hand side) of the Color Gradient Builder.

Rotating a Linear Gradient

Use the angle control to rotate the Linear Gradient. The angle control indicates the
current rotation angle of the gradient with the line that isin the half circle. If the gradient
isvertical, the indicator linein the half circle will be vertical. If the gradient isangled to
the right, the indicator line will go off to the right, and so on. Y ou can rotate the Linear
Gradient by clicking the mouse within the half circle. Y ou can also drag the rotation
angle by dragging the indicator line back and forth. Asthe rotation is changed the color
Gradient Indicator (above the angle control) is redrawn to display the new angle of
rotation.

Selecting a Color for the Color Point

Once you have selected which point(s) that you want to change the color of, use the Color
Selection controls (on the right hand side of the Color Gradient Builder) to select the new
color. The Color Gradient Builder has three methods of selecting acolor. You can use

either the Color Picker, the Color Sliders, or the Color Palette.

At the top of the screen, on the left-hand side of the color selection section, are the Color
Picker controls. These controlsinclude a"Hue Picker" and a"Color Picker Area". The
hue picker lets you select the hue (Red, Green, Blue, etc.) of the color. Place the mouse
over this control, and press the left mouse button to select the desired hue. When the new
hue is selected, the Color Gradient, Color Picker Area, and Color Sliders will be updated
to reflect the new hue.
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Once the hue is selected, you can now pick the color. Place the mouse over the Color
Picker Area and press the left mouse button. Thiswill select the color under the mouse.
The Color Gradient and the Color Sliders will be updated to reflect the newly selected
color. If you hold down the left mouse button while the mouse is moved, the color under
the mouse will be selected as the mouse is moved.

To theright of the Color Picker controlsisthe Color Palette. The Color Palette has 64
preset colors. Not all of the preset colors can be displayed at one time, so thereisa scroll
bar on the right hand side of the Color Palette. Use the scroll bar to scroll through all of
the preset colors. To select a color from the Preset Color Palette, position the mouse over
the desired color and click the left mouse button. When a color is selected from the color
palette, the Color Gradient, Color Picker Area, and the Color Sliders will be updated to
reflect the new color.

Below the Color Picker controls and the Color Palette display are the Color Sliders.
There are two numerical systemsfor defining colors. They are RGB (Red, Green, Blue)
and HL S (Hue, Luminance, Saturation). Both of the systems are used to define the same
thing (like yards and meters). Adjusting one will automatically change the other. You
can use either set of didersto adjust the color. When you use one set of diders to change
the color the other set is automatically updated to reflect the change.

There are four waysto adjust the RGB, HLS, Transparency, and Background Video
levels. They can be adjusted by dragging sliders. They can aso be adjusted by double-
clicking the number box and entering the new value with the keyboard. To "fine-tune"
the levels, use the increment and decrement buttons. The value will be increased or
decreased by one each time you press one of these buttons. These buttons will auto-
repeat if you hold them down. The values may also be changed by clicking on the
number box and dragging the mouse.

This section includes an lllegal Color Indicator to warn you if the selected color exceeds
NTSC or PAL limitations. The lllegal Color Indicator will appear red if you have
selected anillegal color, otherwise it will appear green.

To theright of the Illegal Color Indicator isa"Transparent” button. Pressing this button
will set the transparency level to full (255). This makes the color fully transparent. This
portion of the color gradient will not be visible. You will see what is behind it on screen.

To theright of the "Transparent” button isa"Background Video" button. Pressing this

button will set the Background Video level to full (255). This portion of the color
gradient will be displayed using Background Video.
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To theright of the "Background Video" buttonisa"Pick Color From Screen" button.
Pressing this button will change the mouse cursor to look like an eye dropper. Move the
mouse to the position of the screen that you want to copy the color of, and press the left
mouse button. The color under the mouse will be selected.

Once you have finished changing the color of the selected color point(s), you can select
another color point to change the color of.

Final steps

When you are finished creating the new Color Gradient (or modifying an existing
gradient) press the "OK" button and the Color Gradient Builder window will close. Any
changes to the color gradients must be saved with the project settings. Otherwise they
will revert to the old Color Gradients when the project is opened again.
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Chapter 13
Using Power CG pagesin Speed Razor

This chapter only applies to your software if you have the model of Power CG that is
designed to work with the in:sync, Speed Razor. It describes how to use Power CG pages
in Speed Razor. It assumes that you are familiar with creating pages in Power CG. It also
assumes that you are familiar with the operation of Speed Razor.

If you are not familiar with the process of creating pages in Power CG, | recommend that
you refer to the Power CG manual. If you are not familiar with the operation of Speed
Razor, | recommend that you refer to the Speed Razor Users Guide.

There are two main steps in using the Power CG for Speed Razor. Thefirst stepistitle
creation. Thisinvolves editing your title pages and saving them to disk. Page creation is
the same for all models of Power CG and is covered in the Power CG manual.

The second step is using the Power CG pages once they have been created. There are two
ways to use Power CG pages in Speed Razor. The most straightforward method is to
create a TGA image and add it to the Speed Razor Timeline. The most powerful method
isto use the Power CG plugin.

Y ou can use either of these methods to display the Power CG titles. Y ou can even
intermix them in the same project. We will discuss how to use both methods in this
Tutorial.

Using TGA images

To use the TGA Images created by Power CG you first need to create the TGA images.
Thisisdone by using the "Export Page" button in the "Shortcuts" Window of the
Power CG.

Start Power CG and open the "Show_off" project by selecting the "Open Project”
command from the "File” menu. Y ou will notice that the pages that were created in the
SHOW_OFF project appear in the Project Manager on the |eft-hand side of the screen.
Scroll down the project manager list until you find the EDIT8 page and select it. The
EDIT8 pageisloaded and it appearsin thetitle window. This page has a background
graphic. Remove the background graphic by pressing the "No Graphic (Background
Video)" button on the "Background - Image" control tab. Notice that the background
of the page turns black. When this page is used in Speed Razor you will see the
background video in the background. Export this page asa TGA image by pressing the
"Export Page" button in the "Shortcuts” window. Thiswill create afile called
EDIT8.TGA on your hard drive. Thisimage fileis a 32-bit TGA file with an apha
channel.
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Exit Power CG and start Speed Razor. Open an existing project or create one with a
video clip on thetimeline. Import the TGA image into the Speed Razor Library window.
Thisis done by selecting the “Import Media” or “Add Media” command from the “File”
menu.

Power CG savesthe TGA imagesin afolder that has the same name as the Power CG
project inthe "POWERCG\PROJECTS" directory/folder. So, to load the TGA file that
we just created, we need to find the "POWERCG" folder. Thisisthe folder that Power
CGisinstaled in. Open the PROJECTS folder in the POWERCG folder, then open the
SHOW_OFF folder. Noticethat thereisafileinthisfolder caled EDIT8.TGA. Thisis
the file that we exported from the Power CG. Double-click thisfile to import it into the
Speed Razor Library window.

Drag the image from the Library window to the time line and position it so that it will
title the portion of the video that you want to have titled.

Preview this clip. Notice that it has the EDIT8 title page superimposed over the video.
Thisis how you use a TGA image created by Power CG to title your video.

Using the Power CG plugin

By far the most powerful way to use Power CG pagesin Speed Razor isto use the Power
CG plugin. Thiswill alow you to select which Power CG page you want to title the clip
with. The plugin also allowsyou select a“Fade In” and “Fade Out” timefor thetitle.

If the page was composed as a ROLL page, the page will roll. If the page was composed
as acrawl page, the page will crawl. Power CG can aso be launched from within the
plug in. When Power CG is launched from the Speed Razor plugin, the first frame of the
clip that is selected as the source for the title will appear as a background in the Power
CG titling window.

The Power CG Pluginsin Speed Razor appear as Video Effects. There are two different
Speed Razor plugins supplied with Power CG. POWER_CG.VFX isasourced plugin.
Thisisthe one you will usein most cases. POWER_CGU.VFX isthe Unsourced
plugin. Thisisthe one you use when to want to do an effect on thetitle (such asaDVE
move), but not on the video behind it. See the Speed Razor Users Guide for more
information about selecting sources for video effects.

Start Speed Razor and open an existing project, or create one with avideo clip on the
timeline. Load the Power CG plugin into the Library by selecting the “ Add Effect(s)”
command from the “File’ menu. Select the POWER_CG.VFX by double clicking on it.
The Power CG Icon will now appear in the Library window.
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Drag the Power CG Icon from the library window to the timeline and position it so that it
will apply thetitle to the video clip that you want to title. The“Select Power CG
Page” window will be displayed. The*“Select Power CG Page” window appears

below.

Select Power CG Page
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Select Power CG Page Window

Thiswindow displays the pages that are in the current Power CG project. The pages are
shown in thelist on the left-hand side. The pagesin thislist can be represented with just
the page name or as a Picon (a Picon is aminiature picture of the page). Y ou can select

whether this list displays the names or the Picon's by making the appropriate selection in

the show page section of this window.

Notice that the current page entry is blank. This means that no Power CG page has been
selected yet. Select the page that you want to title this clip with and it will appear in this
box. The “Project” section of thiswindow displays the current project that the listed
pages are from. Y ou can select a new project by pressing the “ Select New Project”

button in this section.
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The fade section of thiswindow allows you to independently set the “Fade In” and
“Fade Out” duration of the page. The Page Transition section of the window shows the
type of page that you have selected. If aroll page is selected, the word “ROLL” will
appear. If acrawl pageis selected, the word “CRAWL” will appear. If neither aroll nor
crawl is selected, the word “NORMAL” will appear.

Scroll the list of available pages down until you seethe “EDIT8” page. Select the EDITS8
page and it will appear as the current page.

Pressing the “Compose/Edit Pages” button will display the Power CG Page
Composition Window. The first frame of the video clip that the title uses as a source will
appear in the background of the Page Composition Window (of course, if the page has a
background graphic or color gradient box you may not be able to see the background
video). When you’ ve finished editing the page, exit Power CG and the system will return
you to Speed Razor.

When you have selected the page and set the “Fade In” and “Fade Out” durations, press
the “OK” button and the “ Select Power CG Page” window will disappear. Y ou should
now set the video source for the title effect. Preview thisclip, notice that the “EDIT8”
title page is superimposed over the video clip.

Y ou can go back at any time and change the selected page and the Fade In and Fade Out
durations of the title by moving the mouse over thetitle effect and double clicking the left
mouse button. The“Select Power CG Page” window will re-appear. Make any
desired changes and press the “OK” button. Thisishow you use the Power CG Plugin to
title your video.
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Rolling pages

A Roll page in the Power CG is composed as asingle page. A Roll page can be up to
1000 rows of text in length. To create a Roll page, start Power CG and select the "New
Page" command from the "File" menu. When you are asked to "select the type of
page that you want to create", select "Roll". Thiscreates anew Roll page. This page
isjust like anormal page except that when you are composing the page, and reach the
bottom of the screen, the page is scrolled up to make room for the new text.

What you have finished composing the roll page, save it. The page can then beused in a
Speed Razor project. A Roll page can be used in the timeline just like any other page
with the following differences:

The page transition type in the "Select Power CG Page" window will be displayed as
"ROLL". When the pageisrendered, it will roll from bottom of the screen to the top of
the screen. The speed of the roll is determined by two factors, the number of linesin the
roll, and the length of time that the page is given on the time line. The speed will
automatically adjust so that the amount of data on the roll page will be displayed in the
allotted time.

When a Roll begins, the first screen of the Roll page appears. |f you want the page to
start below the bottom of the screen and roll up onto the screen, you need to compose the
page with blank lines on the first few rows (the rows that are visible at the top of the

page).

Theroll finishes when the last row of text appears at the bottom margin. If you want the
text to continue and scroll all of the text off of the top of the screen, move the cursor
down until al of the text is scrolled off of the top of the screen and enter asmall dot (.).
Remove the edge from the dot and set the height to zero (0) scan lines. Thiswill make
the dot invisible.
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Crawling pages.

A Crawl pagein Power CG is composed as one long row of text. A Crawl page can be up
to 8000 charactersin length. To create a Crawl page, start Power CG and select the
“New Page” command from the “File” menu. When you are asked to “select the type
of page you want to create”, select “Crawl”. This creates anew Crawl page. This
Crawl page only has one row of text. When you are composing a Craw! page, and reach
the right margin, the page is scrolled to the |eft to make room for the new text.

The Crawl row can be positioned vertically on the page using any of the commands that
will move arow vertically. The most common position for a crawl is along the bottom of
the screen. The easiest way to position the crawl thereisto “Bottom Justify” the page
after the text has been composed.

When you have finished composing the crawl, saveit. The page can then beusedina
Speed Razor project. A Crawl page can be used in the timeline just like any other page
with the following differences:

The“Page Transition” typein the “Select Power CG Page” window will be
displayed as“CRAWL”. When the pageisrendered, it will crawl from the right side of
the screen to the left.

The speed of the crawl is determined by two factors, the length of the crawl text, and the
length of time that the page is given on the timeline. The speed will automatically be
adjusted so the crawl text will be displayed in the allotted time.

When a Craw! begins, the first screen of the Crawl page appears. If you want the crawl to
start at the right side of the screen and crawl onto the screen, you need to leave spaces at
the beginning of the Crawl message (the text that is visible on the first screen of the
crawl).

The crawl finishes when the last character of the crawl appears at the right margin. 1f you
want the text to continue to crawl off the left side of the screen, move the cursor to the
right (beyond the last character), until all of the text scrolls off of the screen, and enter a
small dot (.). Remove the edge from the dot and set the height of it to zero (0) scanlines.
Thiswill make the dot invisible.
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Chapter 14
Using Power CG pagesin Premiere

This chapter only applies to your software if you have the model of Power CG that is
designed to work with Adobe Premiere. It describes how to use Power CG pagesin
Adobe Premiere. It assumesthat you are familiar with creating pagesin Power CG. It
also assumes that you are familiar with the operation of Adobe Premiere.

If you are not familiar with the process of creating pages in Power CG, | recommend that
you refer to the Power CG manual. If you are not familiar with the operation of Adobe
Premiere, | recommend that you refer to the Adobe Premiere manual.

There are two main stepsin using the Power CG for Premiere. Thefirst stepistitle
creation. Thisinvolves editing your title pages and saving them to disk. Page creation is
the same for all models of Power CG and is covered in the Power CG manual.

The second step is using the Power CG pages once they have been created. There are two
ways to use Power CG pagesin Premiere. The most straightforward method is to create a
TGA image and add it to the Premiere Timeline. The most powerful method is to use the
Power CG plugin.

Y ou can use either of these methods to display the Power CG titles. Y ou can even
intermix them in the same project. We will discuss how to use both methods in this
Tutorial.

Using TGA images

To use the TGA Images created by Power CG you first need to create the TGA images.
Thisisdone by using the "Export Page" button in the "Shortcuts" Window of the
Power CG.

Start Power CG and open the "SHOW _OFF" project by selecting the "Open Project”
command from the "File” menu. Y ou will notice that the pages that were created in the
SHOW_OFF project appear in the Project Manager on the |eft-hand side of the screen.
Scroll down the project manager list until you find the EDIT8 page and select it. The
EDITS8 pageisloaded and it appearsin thetitle window. This page has a background
graphic. Remove the background graphic by pressing the "No Graphic (Background
Video)" button on the "Background - Image" control tab. Notice that the background
of the page turns black. When this page is used in Adobe Premiere you will seethe
background video in the background. Export this page asa TGA image by pressing the
"Export Page" button in the "Shortcuts” window. Thiswill create afile called
EDIT8.TGA on your hard drive. Thisimagefileisa 32-bit TGA file with an alpha
channel.
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Exit Power CG and start Adobe Premiere. Open an existing Premier project or create one
with avideo clip on thetimeline. Import the target image into the project by pressing the
right mouse button over the "Project” window and then select the import file command.

Power CG saves the TGA imagesin afolder that has the same name as the Power CG
project inthe "POWERCG\PROJECTS" directory/folder. So, to load the TGA file that
we just created, we need to find the "POWERCG" folder. Thisisthe folder that Power
CGisinstaled in. Open the PROJECTS folder from with the POWERCG folder, then
open the SHOW _OFF folder. Noticethat thereisafilein thisfolder called
EDIT8.TGA. Thisisthefile that we exported from the Power CG. Double-click thisfile
to import it into the Premiere project.

Drag the image to the time line and drop it on the S1 layer. Position it so that it will title
the portion of the video that you want to have titled.

Position the mouse over this TGA image and press the right mouse button. Select the
"Transparency" command from the pop-up menu. The"Transparency Settings"
dialog box will appear. Select the "Black Alpha Matte" setting from the "Key Type"
selection box. Closethisdialog box by pressing the "OK" button.

Preview this clip. Notice that it has the EDITS title page superimposed over the video.
Thisis how you use a TGA image created by Power CG to title your video.

Using the Power CG plugin

By far the most powerful way to use Power CG pagesin Adobe Premiere isto use the
Power CG plugin. Thiswill allow you to select which Power CG page you want to title
the clip with. The plugin also allows you select a“Fade In” and “Fade Out” time for
thetitle. If the page was composed as a ROLL page, the page will roll. If the page was
composed as a crawl page, the page will crawl. Power CG can also be launched from the
Premiere plugin.

When Power CG is launched from the Premiere plugin, thefirst frame of the clip that
you are titling will appear as a background in the Power CG titling window.
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Start Adobe Premiere and open an existing project or create one with avideo clip on time
line. Place the mouse over the video clip that you want to title and press the right mouse
button. Select the “Filters” entry from the pop-up menu. This displays the “Filters”
dialog box. Thisdialog box displaystwo lists. Thelist on the left displays the filters that
are availablein your system. Thelist on the right displays the filters that are currently
applied to the selected video clip. Scroll down the left list until you find the Power CG
entry and double-click it. The*“Select Power CG Page” dialog box will be displayed.
The “Select Power CG Page” dialog box appears below.
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Select Power CG Page window

This dialog box displays the pages that are in the last project that the Power CG was
working on. The pages are shown in the list on the left-hand side. The pagesin thislist
can be represented with just the page name or as a Picon (a Picon is a miniature picture of
the page). Y ou can select whether this list displays the names or the Picon's by making
the appropriate selection in the show page section of this dialog box.
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Notice that the current page entry is blank. This means that no Power CG page has been
selected yet. Select the page that you want to title this clip with and it will appear in this
box. The“Project” section of the dialog box displays the current project that the listed
pages are from. You can select anew project by pressing the “ Select New Project”
button in this section.

The fade section of this dialog box allows you to independently set the “Fade In” and
“Fade Out” duration of the page. The Page Transition section of the dialog box shows
the type of page that you have selected. If aroll pageis selected, the word “ROLL” will
appear. If acrawl pageis selected, the word “CRAWL” will appear. If neither aroll nor
crawl is selected, the word “NORMAL” will appear.

Scroll the list of available pages down until you seethe “EDIT8” page. Select this page
and it will appear as the current page.

Pressing the “Compose/Edit Pages” button will display the Power CG Page
Composition Window. Thefirst frame of the video clip that thetitle is applied to will
appear in the background of the Page Composition Window (of course, if the page has a
background graphic or color gradient box you may not be able to see the background
video). When you're done editing the page, exit Power CG and the system will return you
to Premiere.

When you're done selecting the page and setting the “Fade In” and “Fade Out”
durations, press the “OK” button and the “ Select Power CG Page” dialog box will
disappear. Power CG now appears as one of the current filtersfor thisclip. Pressthe
“OK” button to close the “Filters’ dialog box. Preview this clip, notice that has the
“EDITS8" title page is superimposed over the video clip.

Y ou can go back at any time and change the selected page and the Fade In and Fade Out
durations of the title by moving the mouse over the titled clip and pressing the right
mouse button. Select the “Filters” entry from the pop-up menu and the “Filters” dialog
box appears. Double-click on Power CG in the current list and the “ Select Power CG
Page” dialog box will re-appear. Make any desired changes and press the “OK” button.
Pressthe “OK” button in the “Filters” dialog box to closeit. Thisishow you use the
Power CG for Premier Plugin Filter to title your video.
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Making titles shorter than the clip

Normally, when Premiere applies afilter to aclip, it is applied to the entire clip. If you
want to apply the title to only a portion of the clip, you must split the clip using the razor
tool. Select the razor tool from the bottom of the construction window, thisistheicon
that looks like arazor blade (right next to the little flags). Once the razor tool is selected,
select where you want to split the clip and press the left mouse button. This divides the
clip into two pieces. Once you have divided the clip, you can apply thefilter (title) to the
portion of the clip that you want to title.

For more information on splitting clips see splitting clipsin a Premier help system, or the
Adobe Premiere users guide.

Making titles longer than the clip

There are two ways to apply atitle (filters) to multiple video clips. The first method is
done using the “Range Select Tool” to select the multiple clips. The second method
involves creating a blank TGA graphic, placing that in a superimpose track over the clips
that you want to title and applying the title (filter) to the blank TGA graphic.

To title multiple clips using the “Range select tool”, select the range select tool from
the bottom of the construction window. Thisistheicon that looks like arectangle (to the
left of the magnifying glassicon).

Drag thistool across the clipsin the construction window that you want to select. When
multiple clips are selected, adding atitle will apply it to all selected clips.

Adding in atitle to multiple clips works just like adding the title to each individual clip.
This means, that if you set aFade In or Fade Out time, the title will fade in and fade out
between each clip. To solve this problem you should set the Fade In and Fade Out
settingsto 0.

Once thetitle has been added to the multiple clips, modify the title (filter) on the first clip
to set the Fade Intime. Modify thetitle on the last clip to set the Fade Out time.

This method will not work with ROLL and CRAWL pages because the entire roll and

crawl page will be displayed once for each clip. To add roll and crawl titles to multiple
clips, the blank TGA image method it is recommended.
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The first step in using the blank TGA image method isto create the blank TGA image.
To do this start the Power CG. Select the “New Page” command from the file menu to
create anew blank page (the page type should be normal). Select the “Save Page As...”
command from the “File” menu. Thiswill display the“Save Page As” dialog box.
Find the main POWERCG folder (thisisthe folder that Power CG isinstalled in).
Changethe“Save As Type” selection box to select “ Targa Format (*. TGA)”. Enter
the name “BLANK” asthe filename and press the “Save” button. Y ou now have a blank
TGA image named “BLANK.TGA” in the Power CG folder. Exit Power CG by selecting
the “Exit” command from the “File” menu.

Position the mouse over a blank portion of the Adobe Premiere Project Window and
press right mouse button. Select the import file command from the pop-up menu and
import and the BLANK.TGA graphic image that you created in the POWERCG folder.
Drag thisimage to the S1 superimpose track and position it over the clips that you want
to title. Position the mouse over the BLANK.TGA image and press the right mouse
button. Select the transparency command from the pop-up menu and the “ Transparency
Settings” dialog box will appear. Select the “Black Alpha Matte” setting from the
“Key Type” selection box. Close this dialog box by pressing the “OK” button.

Position the mouse over the BLANK.TGA image and press the right mouse button.

Select the “Filters” command from the pop-up menu and apply the desired Power CG
title to this graphic (as described earlier). Preview this project and notice that the selected
Power CG page is superimposed over the underlying clips. If you selected a page that has
a background (Background Graphic or a Background Color Gradient), the underlying
video clipswill not appear behind the page.
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Rolling pages

A Roll page in the Power CG is composed asasingle page. A Roll page can be up to
1000 rows of text in length. To create a Roll page, start Power CG and select the "New
Page" command from the "File" menu. When you are asked to "select the type of
page the want to create", select "Roll". This creates anew Roll page. Thispageisjust
like anormal page except that when you are composing the page, and reach the bottom of
the screen, the page is scrolled up to make room for the new text.

What you have finished composing the roll page save it. The page can then be used in an
Adobe Premiere project. A Roll page can be used in Premiere just like any other page
with the following differences:

The page transition type in the "Select Power CG Page" dialog box will be displayed
as"ROLL".

When the pageisrendered in Premiere, it will roll from bottom of the screen to the top of
the screen.

The speed of theroll is determined by two factors, the number of linesin theroll, and the
length of time that the page is given on the time line. The speed will automatically adjust
so that the amount of data on the roll page will be displayed in the alotted time.

When aRoll begins, the first screen of the Roll page appears. If you want the page to
start below the bottom of the screen and roll up onto the screen, you need to compose the
page with blank lines on the first few rows (the rows that are visible at the top of the

page).

Theroll finishes when the last row of text appears at the bottom margin. If you want the
text to continue and scroll all of the text off of the top of the screen, move the cursor
down until al of the text is scrolled off of the top of the screen and enter asmall dot (.).
Remove the edge from the dot and set the height to zero (0) scan lines. Thiswill make
the dot invisible.
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Crawling pages.

A Crawl pagein Power CG is composed as one long row of text. A Crawl page can be up
to 8000 charactersin length. To create acrawl page, start Power CG and select the “New
Page” command from the “File” menu. When you are asked to “select the type of
page you want to create”, select “Crawl”. Thiscreatesanew “Crawl!” page. This
Crawl page only has one row of text. When you are composing a Craw! page, and reach
the right margin, the page is scrolled to the |eft to make room for the new text.

The Crawl row can be positioned vertically on the page using any of the commands that
will move arow vertically. The most common position for a crawl is along the bottom of
the screen. The easiest way to position the crawl thereisto “Bottom Justify” the page
after the text has been composed.

When you have finished composing the crawl, save it. The page can then be used in an
Adobe Premiere project. A Crawl page can be used in Premiere just like any other page
with the following differences:

The“Page Transition” typein the “Select Power CG Page” dialog box will be
displayed as“CRAWL".

When the pageis rendered in Premiere, it will crawl from the right side of the screen to
the left.

The speed of the crawl is determined by two factors, the length of the crawl text, and the
length of time that the page is given on the timeline. The speed will automatically be
adjusted so the crawl text will be displayed in the allotted time.

When a Craw! begins, the first screen of the Crawl page appears. If you want the crawl to
start at the right side of the screen and crawl onto the screen, you need to leave spaces at
the beginning of the Crawl message (the text that is visible on the first screen of the
crawl).

The crawl finishes when the last character of the crawl appears at the right margin. 1f you
want the text to continue to crawl off the left side of the screen, move the cursor to the
right (beyond the last character), until all of the text scrolls off of the screen, and enter a
small dot (.). Remove the edge from the dot and set the height of it to zero (0) scanlines.
Thiswill make the dot invisible.
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Chapter 15
Using Power CG pagesin MediaStudio

This chapter only applies to your software if you have the model of Power CG that is
designed to work with Ulead Systems, MediaStudio. It describes how to use Power CG
pages in MediaStudio. It assumes that you are familiar with creating pagesin Power CG.
It also assumes that you are familiar with the operation of MediaStudio.

If you are not familiar with the process of creating pages in Power CG, | recommend that
you refer to the Power CG manual. If you are not familiar with the operation of
MediaStudio, | recommend that you refer to the MediaStudio manual.

There are two main steps in using the Power CG for MediaStudio. Thefirst stepistitle
creation. Thisinvolves editing your title pages and saving them to disk. Page creation is
the same for all models of Power CG and is covered in the Power CG manual.

The second step is using the Power CG pages once they have been created. There are two
ways to use Power CG pagesin MediaStudio. The most straightforward method isto
create a TGA image and add it to the MediaStudio Timeline. The most powerful method
isto use the Power CG plugin.

Y ou can use either of these methods to display the Power CG titles. Y ou can even
intermix them in the same project. We will discuss how to use both methods in this
Tutorial.

Using TGA images

To use the TGA Images created by Power CG you first need to create the TGA images.
Thisisdone by using the "Export Page" button in the "Shortcuts" Window of the
Power CG.

Start Power CG and open the "SHOW _OFF" project by selecting the "Open Project”
command from the "File” menu. Y ou will notice that the pages that were created in the
SHOW_OFF project appear in the Project Manager on the |eft-hand side of the screen.
Scroll down the project manager list until you find the EDIT8 page and select it. The
EDIT8 pageisloaded and it appearsin thetitle window. This page has a background
graphic. Remove the background graphic by pressing the "No Graphic (Background
Video)" button on the "Background - Image" control tab. Notice that the background
of the page turns black. When this page is used in MediaStudio you will see the
background video in the background. Export this page asa TGA image by pressing the
"Export Page" button in the "Shortcuts” window. Thiswill create afile called
EDIT8.TGA on your hard drive. Thisimage fileis a 32-bit TGA file with an apha
channel.
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Exit Power CG and start MediaStudio. Open an existing project or create one with a
video clip on thetimeline. Import the TGA image into the project by pressing the right
mouse button over the "Timeline" window and then select the “Image file” command.

Power CG savesthe TGA imagesin afolder that has the same name as the Power CG
project inthe "POWERCG\PROJECTS" directory/folder. So, to load the TGA file that
we just created, we need to find the "POWERCG" folder. Thisisthe folder that Power
CGisinstaled in. Open the PROJECTS folder in the POWERCG folder, then open the
SHOW_OFF folder. Noticethat thereisafileinthisfolder called EDIT8. TGA. Thisis
the file that we exported from the Power CG. Double-click thisfile to import it into the
MediaStudio project.

Drag the image to the time line and drop it on the V1 layer. Position it so that it will title
the portion of the video that you want to have titled.

Position the mouse over this TGA image and press the right mouse button. Select the
"Overlay Options..." command from the pop-up menu. The "Overlay Options"
window will appear. Select the "Alpha Channel” setting from the " Type" selection box.
Close this window by pressing the "OK" button.

Preview this clip. Notice that it has the EDIT8 title page superimposed over the video.
Thisis how you use a TGA image created by Power CG to title your video.

Using the Power CG plugin

By far the most powerful way to use Power CG pagesin MediaStudio is to use the Power
CG plugin. Thiswill alow you to select which Power CG page you want to title the clip
with. The plugin also allowsyou select a“Fade In” and “Fade Out” timefor thetitle.
If the page was composed as a ROLL page, the page will roll. If the page was composed
as acrawl page, the page will crawl. Power CG can aso be launched from within the

plug in.

When Power CG is launched from the MediaStudio plugin, the first frame of the clip that
you are titling will appear as a background in the Power CG titling window.

Start MediaStudio and open an existing project or create one with avideo clip on the
timeline. The Power CG plugin appearsin MediaStudio as aVideo Filter. There are two
ways of applying aVideo Filter to aVideo Clip. Thefirst method isto select “Video
Filters” in the “Production Library”, and select the “Power CG” video filter. Drag the
Power CG Icon up to the video clip in the timeline that you want to add atitleto. The
“Select Power CG Page” window (shown below) will appear. Use this window to
select which Power CG page you want to use to title the video clip.
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The second method is to place the mouse over the video clip that you want to title and
press the right mouse button. Select the “Video Filters’ entry from the pop-up menu.
This displaysthe “Video Filters” window. Thiswindow displaystwo lists. Thelist on
the left displaysthe filtersthat are available in your system. Thelist on the right displays
the filters that are currently applied to the selected video clip. Scroll down the left list
until you find the Power CG entry and double-click it. The “Select Power CG Page”
window will be displayed. The “Select Power CG Page” window appears below.

Select Power CG Page |

—Page

Current: Iu:harwiu:l

— Project

Current: IDemD

Select Mew Project |

—Fade

Fade Irn: [0 Frames

Fade Out; [0 Frames

— Page Transition
Type:
[NORMAL

—Show Fage Cancel
" Mames 4|

Hcharwids
hcrwuemi Compoze/Edit Pages

Select Power CG Page window

Thiswindow displays the pages that are in the current Power CG project. The pages are
shown in thelist on the left-hand side. The pagesin thislist can be represented with just
the page name or as a Picon (a Picon is aminiature picture of the page). Y ou can select
whether this list displays the names or the Picon's by making the appropriate selectionin
the show page section of this window.
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Notice that the current page entry is blank. This means that no Power CG page has been
selected yet. Select the page that you want to title this clip with and it will appear in this
box. The“Project” section of thiswindow displays the current project that the listed
pages are from. You can select anew project by pressing the “ Select New Project”
button in this section.

The fade section of this window allows you to independently set the “Fade In” and “Fade
Out” duration of the page. The Page Transition section of the window shows the type of
page that you have selected. If aroll page is selected, the word “ROLL” will appear. If a
crawl page is selected, the word “CRAWL” will appear. If neither aroll nor crawl is
selected, the word “NORMAL” will appear.

Scroll thelist of available pages down until you seethe “EDIT8” page. Select this page
and it will appear as the current page.

Pressing the “Compose/Edit Pages” button will display the Power CG Page
Composition Window. Thefirst frame of the video clip that thetitle is applied to will
appear in the background of the Page Composition Window (of course, if the page has a
background graphic or color gradient box you may not be able to see the background
video). When you'’ ve finished editing the page, exit Power CG and the system will return
you to MediaStudio.

When you have selected the page and set the “Fade In” and “Fade Out” durations, press
the “OK” button and the “ Select Power CG Page” window will disappear. Power CG
now appears as one of the current filtersfor thisclip. Pressthe “OK” button to close the
“Video Filters” window. Preview this clip, notice that the “EDIT8” title pageis
superimposed over the video clip.

Y ou can go back at any time and change the selected page and the Fade In and Fade Out
durations of the title by moving the mouse over thetitled clip and pressing the right
mouse button. Select the “Video Filters” entry from the pop-up menu and the “Video
Filters” window will appear. Select the Power CG in the “Applied filters” list and press
the “Options...” button. The*“Select Power CG Page” window will re-appear. Make
any desired changes and press the “OK” button. Pressthe “OK” button in the “Video
Filters” window to closeit. Thisishow you use the Power CG for MediaStudio Plugin
Filter to title your video.

The Power CG Video filter can only be applied to video clips that are on the Va or Vb
layers of the timeline.
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Making titles shorter than the clip

Normally, when MediaStudio applies afilter to aclip, it is applied to the entire clip. If
you want to apply the title to only a portion of the clip, you must split the clip using the
scissorstool. Select the “Scissors Tool” from the toolbar (see the MediaStudio users
guide for more information about the “ Scissors Tool”). Once the Scissors Tool is
selected, select where you want to split the clip and press the left mouse button. This
divides the clip into two pieces. Once you have divided the clip, you can apply the filter
(title) to the portion of the clip that you want to title.

Rolling pages

A Roll page in the Power CG is composed as asingle page. A Roll page can be up to
1000 rows of text in length. To create a Roll page, start Power CG and select the "New
Page" command from the "File" menu. When you are asked to "select the type of
page that you want to create", select "Roll". Thiscreatesanew Roll page. This page
isjust like anormal page except that when you are composing the page, and reach the
bottom of the screen, the page is scrolled up to make room for the new text.

What you have finished composing the roll page, save it. The page can then beused in a
MediaStudio project. A Roll page can be used in the timeline just like any other page
with the following differences:

The page transition type in the "Select Power CG Page" window will be displayed as
"ROLL". When the pageisrendered, it will roll from bottom of the screen to the top of
the screen. The speed of the roll is determined by two factors, the number of linesin the
roll, and the length of time that the page is given on the time line. The speed will
automatically adjust so that the amount of data on the roll page will be displayed in the
allotted time.

When a Roll begins, the first screen of the Roll page appears. |f you want the page to
start below the bottom of the screen and roll up onto the screen, you need to compose the
page with blank lines on the first few rows (the rows that are visible at the top of the

page).

Theroll finishes when the last row of text appears at the bottom margin. If you want the
text to continue and scroll all of the text off of the top of the screen, move the cursor
down until al of the text is scrolled off of the top of the screen and enter asmall dot (.).
Remove the edge from the dot and set the height to zero (0) scan lines. Thiswill make
the dot invisible.
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Crawling pages.

A Crawl pagein Power CG is composed as one long row of text. A Crawl page can be up
to 8000 charactersin length. To create a Crawl page, start Power CG and select the
“New Page” command from the “File” menu. When you are asked to “select the type
of page you want to create”, select “Crawl”. This creates anew Crawl page. This
Crawl page only has one row of text. When you are composing a Craw! page, and reach
the right margin, the page is scrolled to the |eft to make room for the new text.

The Crawl row can be positioned vertically on the page using any of the commands that
will move arow vertically. The most common position for a crawl is along the bottom of
the screen. The easiest way to position the crawl thereisto “Bottom Justify” the page
after the text has been composed.

When you have finished composing the crawl, save it. The page can then be used in a
MediaStudio project. A Crawl page can be used in the timeline just like any other page
with the following differences:

The“Page Transition” typein the “Select Power CG Page” window will be
displayed as“CRAWL”. When the pageisrendered, it will crawl from the right side of
the screen to the | eft.

The speed of the crawl is determined by two factors, the length of the crawl text, and the
length of time that the page is given on the timeline. The speed will automatically be
adjusted so the crawl text will be displayed in the allotted time.

When a Craw! begins, the first screen of the Crawl page appears. If you want the crawl to
start at the right side of the screen and crawl onto the screen, you need to leave spaces at
the beginning of the Crawl message (the text that is visible on the first screen of the
crawl).

The crawl finishes when the last character of the crawl appears at the right margin. 1f you
want the text to continue to crawl off the left side of the screen, move the cursor to the
right (beyond the last character), until al of the text scrolls off of the screen, and enter a
small dot (.). Remove the edge from the dot and set the height of it to zero (0) scanlines.
Thiswill make the dot invisible.
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Chapter 16
On Air Operation

This section of the manual only appliesto your software if you have amodel of Power
CG that has Standalone ON AIR capability. This capability isNOT included in the
Plugin versions of Power CG.

Once you have created the pages that you want to show, and created a page list (if you
want to use one), you areready to go ON AIR. When apageisdisplayed ON AIR, it
appears using the page transition type defined with the page (roll, crawl, wipe, etc.). The
speed of the transition is controlled by the Transition Duration. When automatically
sequencing alist of pages (as defined in the Page List), each page will appear on the
screen for the length of time specified by Dwell Duration.

A page list is used to define which pagesto display (and which order to display them in)
when automatically sequencing pages. They can aso be used to smplify ON AIR
operations and to reduce ON AIR errors.

A pagelistisafilethat contains alist of page names that you want shown asagroup. A
page list can have as many as 250 pages listed init. The pagelist is given its own name
with the extension “*.PGL” added to it. For example, the pagelist “MYLIST” would be
stored in the file named “MYLIST.PGL”. The page list must be stored in the same
directory asthe pages that it lists.

More information about creating and edit page listsisincluded later in this chapter.

Each page can be set to adifferent Transition Type, Transition Duration, and Dwell
Duration. Thisallowsyou to mix different Transition types and speeds in a sequence.
For example: one page could roll onto the screen fast, and the next page could wipe onto
the screen owly. For more information about setting the Transition Type, Duration, and
Dwell Duration see Chapter 17 -- Page Transitions.

There are 2 waysto control the ON AIR operation of the system. These are:

1. Manua Control
The operator manually selects the next page to display and when to display it.

2. Automatic Sequencing
The system automatically displays the pages listed in the Pagelist with the Page
Transition Type, Transition Duration, and the Dwell Duration, which were saved with

the page.
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Manual Control

The manual On Air operation of the Power CG is designed to minimize the risk of On Air
errors. Thisisdone by composing al of the pages and putting them into a page list
before you go ON AIR The Pagelist determines which pages will be displayed and the
order they will be displayed in.

The On Air operation can be as simple as pressing the <Enter> key when you want to
show the next page. If the VGA and Video Outputs are displayed on independent screens
on your system (such as the Fast Video Machine), the system is capable of displaying the
pagesin adifferent order than is defined in the Pagelist. This enables you to handle last
minute changes. This system isreferred to as a Dual Output System.

If the information displayed on the VGA screen and Video outputs are the same (like a
Genlock VGA card), the system cannot display any controls that would alow you to
change the order of the pages. Because displaying these controls would also display them
ON AIR. Thissystem isreferred to as a Single Output System.

The manual On Air operation is different depending on whether you have a Single Output
System or a Dual Output System. Each method is explained separately.

Single Output System

To manually display pages On Air select the “Manual Control...” command from the “On
Air’ menu. When thisis done the Select Pagelist to Show dialog box (shown below) will
appear. Since you are showing the full screen On Air, you don’t want any menus to
display along with the pages that you are showing. This can make manual control
difficult without a page list.

Select Page List to Show

Lookin: | =3 Show_off

Pro_dermo.pol

File narme; g_demo. Open I
Filez of ype: IF'ageLists [* PGEL) j Cancel |

Select Page List to Show dialog box
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Select the Pagelist that you want to show. Once the Pagelist is selected, thefirst pagein
the Pagelist will appear. The page will be displayed full screen. No menus will appear
while the system is showing pages On Air. Once a page is displayed, the next page in the
Pagelist will be loaded. To show the next page, press the <Enter> key.

Each time the <Enter> key is pressed, the page that is loaded will be displayed with the
Transition Type and Transition Duration that was sel ected when the page was created.
After the page is displayed, the next page in the Pagelist will be loaded from the disk. If
you press <Enter> before the next page is loaded, the page will not start to display
immediately. The system will finish loading the page before it starts to display it.

When the last page in the Pagelist is displayed, the first page in the Pagelist will be
loaded again. The Pagelist will continue to repeat as long as you keep displaying the
pages. When you want to leave the On Air mode, press the <Esc> key. The system will
return to editing mode.

Dual Output System
To manually display pages On Air select the “Manual Control...” command from the “On
Air’ menu. When thisis done the On Air Operations dialog box (shown below) will

appear.

+ On Aur Operations E
Tl-;gz&sm eied ﬂ Eajea:f;gl [~ Mest Ready _I“ In = Igut - | o
TEST PAG pope 300 300 100%
TEXTSETR.PAG Air Page,
TEXTURE.PAG Fiead Nest |1D |1E' 100 %
TITS.PAG Frames Framesz
tst1.PAG i
tst2 PAG
TWTRTEST PAG big Selected Page ¥ Keyer On

THTSETRZPAG [ ] |rolidema II:I

utahlake. PAG faces —I 0 Fade | 0
ww@ﬁmj bemtuine hd| Go Off Air | = | - il

Fade Duration Ken Level

On Air Operations dialog box

Showing pages On Air is simply a matter of selecting which page to show next, showing
the page, and controlling the Keyer/Fader. If you have created a Pagelist, the On Air
operation may be as simple as pressing the <Enter> key (or the “ Air Page, Read Next”
button). Each timethisis done, the current page will display with the Transition Type,
and Transition Duration that were selected when the page was created. Once the pageis
shown, the next page in the Pagelist will be loaded from the disk. If you pressthe
<Enter> key (or the “Air Page, Read Next” button) before the next page is |oaded
(indicated by the “Next Ready” check box), the page will not start to display immediately.
The system will finish loading the page before it starts to display it.
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Selecting Which Page to Show Next

The On Air Operations dialog box has two (2) lists. The left list shows the pages
available in the current project. The right list shows the contents of the current Pagelist.
Selecting a page from either of these lists will select it as the next page.

Showing the Page

Once the next page to show has been selected, you can display it by pressing either the
“Air Selected Page” or “Air Page, Read Next” button. When thisis done the page will be
loaded from the disk (if it isn’t already |oaded) and display it on the screen with the
Transition Type and Transition Duration that were selected when the page was created.

If the “ Air Page, Read Next” button was pressed, the next page in the Pagelist will be
loaded from the disk. Onceit isloaded, it will appear on the VGA screen.

Pre-loading Pages

If the page to be shown has not been pre-loaded, it will need to be read from the disk
before it can be displayed. This can take afew seconds. If you pre-load the page it will
appear immediately when you press the button, (When | say, | want the page now,

“I WANT IT NOW”). A page can be pre-loaded by either double clicking it in one of the
lists, or by selecting it and pressing the “ Next Ready” check box. While the page is being
loaded from the disk the cursor will change to await icon (hourglass). When the pageis
loaded and ready to be displayed, the “Next Ready” check box will be marked with an
“X” and the page will appear on the VGA (but not ON AIR).

Controlling the Keyer/Fader
The Keyer/Fader can be turned ON and OFF immediately, Faded IN and OUT, or
manually set to aFade Level.

To turn the Keyer/Fader On or Off, select the “Keyer On” check box in the Keyer group
of controls. If the Keyer is ON, it will be turned OFF (the box becomes unchecked and
the Key level isset to 0%). If the Keyer is OFF, it will be turned ON (the box becomes
checked and the Key level is set to 100%).

To Fade the page In or Out, press the “Fade” button. If the Keyer is ON, the page will
Fade Out (the Keyer On box becomes unchecked, and the Key Level goesto 0%). If the
Keyer is OFF, the page will Fade In (the Keyer On box becomes checked, and the Key
Level goesto 100%). The Fade In and Fade Out durations can both be set to different
values. They can either be adjusted by positioning the Fade Duration dliders, or by
entering the duration directly with the keyboard. These values control how long it takes
for a page to Fade In and Fade Ouit.
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The Key Level can be manually set to any value from 0 to 100%. A vaue of 0% shows
only the external video. No text will appear. A value of 100% showsthe full page. Any
value from 1% to 99% only partially shows the page. The Key Level can be adjusted by
positioning the Key Level dider, or by entering the percentage directly with the keyboard.

Going Off Air
When you are finished showing pages, press the “Go Off Air” button. Thiswill return
the system to editing mode.

Automatic Sequencing

When the system auto sequences, it displays the pages that are listed in the selected
Pagelist. The pages are shown with the Transition Type, Transition Duration, and Dwell
Duration that were selected as the Page Attributes when the page was created. These
Page Attributes are stored with the page. To automatically sequence a Pagelist, select the
“Auto Sequence’” command from the “On Air” menu. The Select Page List to Sequence
dialog box (shown below) will appear on the screen.

Select Page List to Sequence

Lookin: | =3 Show_off

Pro_dermo.pol

File narme; g_demo. Open I
Filez of ype: IF'ageLists [* PGEL) j Cancel |

Select Page List to Sequence dialog box

Select the Pagelist that you want to sequence. Thefirst page in the Pagelist will be
displayed. When the page has completed its transition, the next page in the Pagelist is
loaded. The page will stay on the screen for the length of time specified by Dwell
Duration. If the next page has not been completely loaded when it’ stime to show it, the
dwell time will automatically be extended. The system will finish loading the page
before it startsto display it.

When the last page of the Pagelist is displayed, the first page will show again, and the

entire Pagelist will repeat. To stop the page sequencing press the <Esc> key (or the
Cancel button). The system will return to editing mode.
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If your system has independent screens for the VGA and Video Outputs (like the Fast
Video Machine), a status dialog box will appear on the VGA screen. The Auto Sequence
status box (shown below) displays information about the pages that are sequencing

Automatically Sequencing Pages E
Sequencing Page List Current Page List:
char3a edite Ich_demD.ng
chard edit? -
introa inbrod charb editta Page Transition Type
iibrob inbroda edit editd |I:ut
irtrorl charach editl editd - -
intro’l a char edit? editing Transition Duration:
itro:Z charl edit3 examph I
introZa char2 editd exarnph AU s
introZhb charZa edith trnzitnz P
introZo char3 editha pagetr Ol DI es
150 Frames
1] | |
Auto Sequence status box

This box shows the Pagelist that is sequencing and the current page. It also displaysthe
Transition Type, Transition Duration, and Dwell Duration of the page. When the next
page in the Pagelist has been loaded, it will appear on the VGA screen. It will not appear
on the Video Output until the last screen has displayed for the Dwell Duration.

Creatinga PageList

To create anew Page list use the “New Page List” command in the “File” menu. When
thisis done the “Page List Editor” isdisplayed. The new pagelist is empty and untitled.
See the section below (Editing a Page List) for more information about how to add pages
to this new page list.
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Editinga PageList

To edit apage list use the “Open Page List” command in the “File” menu. When thisis

done the Open Page List dialog box (shown below) will appear.

Open Page List
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Open Page List dialog box

Use this dialog box to select the page list that you want to edit.

Once the new Page List is selected, the “Page List Editor” (shown below) is displayed.
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Page List Editor
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Use this Dialog box to edit the Page List. Thelist of pages on the left displays al of the
pages that are available in the current project. The Right List displays the page names
that are currently in the Page List. A PageList isedited by inserting pages into the list, or
deleting pages from the list.

Insert a Page into the Page List

To add a page to the page list, select the position (in the right list) that you want to add it
to. Select the page that you want to insert into the position. There are 3 waysto insert a
page into the page list.

1. Select the page from the list of available pages. The name will appear in the New
Page box. Pressthe*“Insert Page” button.

2. Enter the name of the page to insert into the New Page box and press the “Insert
Page” button.

3. Double click on the page name in the list of available pages.

When apage isinserted into the Page List, it isinserted above the page that is selected in
the Page List (right side). To insert apage at the end of the list, select the empty space
below the last page.

Delete a page from thelist

To delete a page from the page list, select the page name to remove and press the “Delete
Page” button.
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Checking a Page List

Y ou can check a page list to make certain that all of the pagesthat are listed in it actually
exist in the same directory as the pagelist. This helps prevent errors ON AIR when you
try to display a page that doesn’'t exist. To do this pressthe “Check List” button. If a
page can’t be found, a warning similar to the one below will appear.

Check Error |

Can't Find the Page:
WLISANPAGE Shmizzing PAG

Delete it from the Page Lizt?

MNa Cancel

The second line in the warning shows the page and filename of the page that couldn’t be
found. The three buttonsin this box do the following:

Yes

Delete the page from the page list and continue checking the page list.
No

Ignore the error and continue checking the page list.

Cancel

Stop checking the page list.

When the system is finished checking the page list the following message is shown.

Page Lizt Checked |
Mo ather emors were detected
ather that thoze that were
reporked.

Cancel Changesto Page List
Pressing the “Cancel” button will discard any changes that you have made to the Page
List. Thiswill aso closethe Page List Editor box.

143



Save Page List
When you are finished making changes to a page list you need to save these changesto
thedisk. There are 3 methods you can use to do this:

1. Pressthe”Save Page List” button. Thiswill overwrite the old Page List with any
changes that you have made.

2. Pressthe“Save As’ button. Use this when you want to save the changes under a new
name. Thiswill display the “ Save Page List As’ dialog box. Select the new name
and pressthe “OK” button. The page will then be saved under the new name. Do not
change the directory that the page list will be saved in.

3. Pressthe“OK” button. Use this when you are done making changes to the Page List.
Thiswill save the changes you have made and close the Page List Editor.
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Chapter 17
Page Transitions

When pages are shown ON AIR, each page can be displayed with some sort of page
transition. There are anumber of different Page Transition Typesto choose from. You
can control how long the Page Transition takes by setting the Transition Duration. Each
page can be set to different Transition Type, Transition Duration, and Dwell Duration.
Thisletsyou intermix different transition types and durations in a sequence of pages.

One page can roll onto the screen fast, and the next page can wipe on slowly.

These three page attributes (Transition Type, Transition Duration, and Dwell
Duration) are saved with the page. Be sure to set the page attributes before saving the

page.

These page attributes only apply to the pages when they are displayed using the
“Standalone ON AIR” modes of the Power CG. If Power CG pages are added to your
editing systemstimeline, your editing system will not support all of these page attributes.

Not al Transition Types are available in all versions of the Power CG. Some Transitions
require capabilities that are not available in all display cards. The Page Transition Type
drop down box will display the Page transitions that are available on your system.

To set the Page Attributes, select the “Page Transitions’ tab in the Control Tabs Window.
The controls for setting the Page Attributes will then be displayed as shown below.

Character I Edges I Shadows I Colors I Layers I Pozitioning | Fow Spacing | Shapes |
Logog | Backaround - Image I B ackaground - Colors Page Transitions
— Page Tranzition ot Ul
Wipe from Top to Bottom j &+ Top & In from Top % Bottom
Tranzition Duration [400  Frames  Left  Fight " Outto T':l'I:l & Battam
[10-33331 ™ Iri from Sides
Dol Diration | 200 Frames = Battam = Out ta Sides

145



Page Transition Type

There are different categories of page transitions for the Power CG. Some categories
have only 1 transition type (such as Cut). While other categories have many transition
types (such as block transition with 57 types).

The Page Transition Type drop down box displays the current transition type. It isused
to select the new transition type. The drop down box lists every category of transition
type available. If there is only one transition type in a category, the name of the transition
islisted. Selecting thisfrom thelist will select this asthe transition type. If there are
multiple transition types in the category, the nameis followed by 3 dots(...). Selecting
thisfrom the list will display another window so that you can be more specific about
which transition type you want to select.

Once aPage Transition type is selected, it will appear in the Page Transition Type box.
For a detailed description of each Page Transition type, see the section Transition Types
later in this chapter.

Transition Duration

The Transition Duration specifies how much time it takes to perform the page transition.
This controls how fast the page displays when the page is displayed ON AIR. The
duration is specified in frames. In NTSC aframeis 1/30 of asecond. In PAL aframeis
1/25 of a second.

To change the Transition duration, select the Transition Duration box (using either the
keyboard or the mouse) and enter the new value.

Dwell Duration

The Dwell Duration specifies how long the page will remain on the screen when
automatically sequencing pages. The duration is specified in frames. In NTSC aframeis
1/30 of asecond. In PAL aframeis 1/25 of a second.

To change the Dwell duration, select the Dwell Duration box (using either the keyboard
or the mouse) and enter the new value.
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Transition Types
The categories and the number of transition types they contain are listed below:

Number of
Category Transition Types
1-Cut 1
2-Crawl 1
3-Roll 1
4-Wipe 8
5-Block 57
6-1ris 18
7-Sparkle 1

The following isabrief description of each transition type in each category.

1. Cut

When a page is shown with a Cut transition type it comes on immediately (all at
once). With a Cut transition type the Transition Duration is meaningless.

2. Crawl

When apage is displayed with a Crawl transition type, it moves from right to left
across the screen at a speed required to show al of the text in the time specified by
the Transition Duration. For more information about Roll & Crawl speeds, see the

section

titled “Roll and Crawl Speeds’ below.

Since acrawl isonelong row, every row except the top one will disappear. Y ou will
not be able to move the cursor off of thisrow. The crawl row is always the top row of
the page. If you want the crawl to appear in adifferent position on the screen, use one
of the following commands to change the row position:

Move the row by selecting the “Fine Position Text...” entry from the
“Positioning” Control tab.

Justify the page to the bottom mar gin by pressing the “Bottom Justify” entry
from the “Positioning” control tab.

Set the Lower Third Mode by selecting the “Lower Third Mode” entry from
the “ Settings” menu.

After the Page transition type has been set to Crawl, the system enters the crawl
compose mode. In this mode, moving the cursor beyond the right margin will scroll
the row to the left. Moving the cursor beyond the left margin will scroll the row to
the right.
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3.
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Credit Roll (variable length)

A credit roll page rolls onto the screen starting from the bottom. The page moves up
the screen at the speed required to show all of the text in the time specified by the
Transition Duration. The top of the page disappears off the top of the screen asthe
rest of the page appears on the bottom of the screen.

A Credit Roll can be up to 1000 rowslong. Of course, that many rows can’t appear
on the screen at one time. When composing a credit roll, if you move the cursor
below the bottom margin, the page will scroll up to expose more of theroll text. If
you try to move the cursor above the top margin, the page will scroll down.

Roll and Crawl! Speeds

Because of the interlaced nature of video, only certain roll and crawl speeds will
appear smooth. For aRoll or Crawl to show in the time specified by the Transition
Duration, the required speed could be jerky. To solve this problem, the roll and crawl
will start at the next lower speed that is smooth. Asit displays at the slower speed it
will get behind. It will continue to run at the slower speed until it is far enough
behind that running at the next faster speed (that is smooth) will make it end at the
right time.

Wipes
When you select “Wipes...” from the Page Transition Type drop down box, the
“Wipe Transitions” window (shown below) will appear.

Wwipe Origin
= Top € |r from Top & Bottom
€ Qut to Top & B ottom
0 Left " Right _
™ Iry from Sides
™ Battom ™ Out to Sides




Thiswindow shows the various wipe transitions. There are 8 different types of Wipe
Transitions. These are:

Wipe from Top to Bottom
The new page begins to appear at the top of the screen and wipes down toward
the bottom of the screen. The new page covers the old page.

Wipe from Bottom to Top
The new page begins to appear at the bottom of the screen and wipes up
towards the top of the screen. The new page covers the old page.

Wipe from Left to Right
The new page begins to appear at the left side of the screen and wipes towards
the right side of the screen. The new page covers the old page.

Wipe from Right to Left
The new page begins to appear at the right side of the screen and wipes
towards the left side of the screen. The new page covers the old page.

Wipe In from Top & Bottom
The new page begins to appear at both the top and bottom of the screen and
wipes in towards the center of the screen. The new page covers the old page.

Wipe Out from Top & Bottom
The new page begins to appear at the center of the screen and wipes up and
down towards the top and bottom of the screen. The new page covers the old

page.

Wipe In from the Sides
The new page begins to appear at both the left and right sides of the screen
and wipes in towards the center of the screen. The new page covers the old

page.
Wipe Out to the Sides

The new page begins to appear at the center of the screen and wipes both |eft
and right towards both sides of the screen. The new page covers the old page.

Select the desired wipe transition and the type of wipe that is selected will appear in
the Page Transition Type drop down box.
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5. Block Transitions
When you select “Block...” from the Page Transition Type drop down box, the
“Block Transitions” window (shown below) will appear:

Block Starting Position
Reveal Tvpe | | ¢~ UpperLeft © Tap % Upper Right Block Size

¥ Scan  Left & Right o Small

> I :
ZigZag " Lower Left ¢ Bottom ¢ Lower Right Azl

™ Random " Large
= Spiral In ™ Spiral Dt

Block Transitions window.

Thiswindow lets you select the various Block Transitions. There are atotal of 19
different types of block transitions, and 3 different sizes of blocks, for atotal of 57
different Block display types. The basic block transition types are:

Random

The blocks that make up the new page come onto the screen randomly in
small rectangles that cover the old page. Select thistransition type by
selecting the “Random” button in the “Reveal Type” group.

Spira In

The blocks that make up the new page, start to appear at the upper left corner.
These blocks are added to the screen in a Spiral In pattern towards the center

of the screen in aclockwise direction. Select this transition type by selecting

the “Spiral In” button in the “Block Direction” group.

Spiral Out

The blocks that make up the new page, start to appear in the center of the
screen. These blocks are added to the screen in a Spiral Out pattern towards
the edges of the screen in a clockwise direction. Select this transition type by
selecting the “ Spiral Out” button in the “Block Direction” group.
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Scan

The blocks that make up the new page, start to appear at the position specified
by the Block Direction. The blocks scan across the screen. When the other
end of the screen isreached, the next row of blocks are drawn in the same
direction as the previous row of blocks. Select this transition type by selecting
the “Scan” button in the “Reveal Type” group. Select the starting point and
scan direction from the “Block Direction” group. The starting pointsto
choose from are:

Upper Left Corner

The blocks start to appear in the upper left corner of the screen. Each
row of blocks scan left to right/ bottom to top. This continues until the
blocksfill in to the Lower Right corner.

Top

Thefirst row of blocks appear at the top of the screen. Each row of
blocks scan left to right. This continues until the blocksfill in to the
bottom of the screen.

Upper Right Corner

The blocks start to appear in the upper right corner of the screen. Each
row of blocks scan left to right/top to bottom. This continues until the
blocksfill in to the Lower Left corner.

L eft

Thefirst row of blocks appear at the left side of the screen. Each row
of blocks scan top to bottom. This continues until the blocksfill in to
the right side of the screen.

Right

Thefirst row of blocks appear at the right side of the screen. Each row
of blocks scan top to bottom. This continues until the blocksfill in to
the left side of the screen.

Lower Left

The blocks start to appear in the lower left corner of the screen. Each
row of blocks scan left to right/top to bottom. This continues until the
blocksfill in to the Upper Right corner.

Bottom

Thefirst row of blocks appear at the bottom of the screen. Each row
of blocks scan left to right. This continues until the blocksfill in to the
top of the screen.

Lower Right

The blocks start to appear in the lower right corner of the screen. Each
row of blocks scan left to right/top to bottom. This continues until the
blocksfill in to the Upper Left corner.
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ZigZag

These transition types are similar to the Block Scan transition types. The main
differenceis, each row of blocks appearsin a zigzag pattern. When arow of
blocks are drawn, the next row of blocks are drawn in the opposite direction.
Select thistransition type by selecting the “ Zig Zag” button in the “Reveal
Type” group. Select the starting point and scan direction from the “Block
Direction” group.

Transition Block Sizes
The user can choose between three sizes of the blocks that make up the new page.
These are:

Small

The screen is broken up into 4332 blocks. 76 blocks horizontally by 57 blocks
vertically.

Medium

The screen is broken up into 972 blocks, 36 blocks horizontally by 27 blocks
vertically.

Large

The screen is broken up into 300 blocks, 20 blocks horizontally by 15 blocks
vertically.

The size of the block does not affect the Transition Duration (even though there are
more of them). The smaller blocks are displayed faster than the larger blocks. Select
the block size from the “Block Size” group of buttons.

Select the desired block transition and the selected Block Transition type will appear
in the Page Transition Type box.



6. IrisTransitions
When you select “Iris...” from the Page Transition Type drop down box, the Iris
Transitions window (shown below) will appear.

Iriz Irig Pogition
" UpperLeft 1 Top i~ Upper Right
¥ Open
" Left &+ Center " Right
" Cloze
" Lower Left ™ Bottom ™ Lower Right

Iris Transitions window

Thiswindow lets you select the various iristransitions. To select an Iris Transition,
select “Open” or “Close” from the “Iris” group, and select the position from the “Iris
Position” Group. Once selected, the selected Iris Transition will appear in the Page
Transition Type drop down box. There are atotal of 18 Iris Transitions, 9 Iris Open
and 9 Iris Close.

When a page is displayed with an “Iris Open” transition, a rectangular iris appears at
the Iris Position. Thisiris opensto display the new page. With an “Iris Close’
transition, arectangular iris appears around the entire old page and closes towards the
Iris Position. This makes the old page disappear and uncovers the new page.

Each Iristransition can happen at any of 9 positions on the screen. These positions are
described here:

Upper Left Corner

Open:
A rectangular iris appears in the Upper Left Corner of the screen and
opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
Upper Left Corner of the screen. Astheiris closes, the old page
disappears and uncovers the new page.
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Top of Screen

Open:
A rectangular iris appears in the middle of the top of the screen and
opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
middle of the top of the screen. Astheiris closes, the old page
disappears and uncovers the new page.

Upper Right Corner

Open:
A rectangular iris appears in the Upper Right Corner of the screen and
opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
Upper Right Corner of the screen. Astheiris closes, the old page
disappears and uncovers the new page.

Left Side of Screen

Open:
A rectangular iris appears in the middle of the left side of the screen
and opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
middle of the left side of the screen. Astheiris closes, the old page
disappears and uncovers the new page.

Center of Screen

Open:
A rectangular iris appears in the center of the screen and opens up to
display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
center of the screen. Astheiris closes, the old page disappears and
uncovers the new page.



Right Side of Screen

Open:
A rectangular iris appears in the middle of the right side of the screen
and opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
middle of the right side of the screen. Astheiris closes, the old page
disappears and uncovers the new page.

Lower Left Corner

Open:
A rectangular iris appearsin the Lower Left Corner of the screen and
opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
Lower Left Corner of the screen. Astheiris closes, the old page
disappears and uncovers the new page.

Bottom of Screen

Open:
A rectangular iris appears in the middle of the bottom of the screen and
opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
middle of the bottom of the screen. Astheiris closes, the old page
disappears and uncovers the new page.

Lower Right Corner

Open:
A rectangular iris appears in the Lower Right Corner of the screen and
opens up to display the new page.

Close:
A rectangular iris appears around the old page and closes towards the
Lower Right Corner of the screen. Astheiris closes, the old page
disappears and uncovers the new page.
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7. Sparkle
When a page is displayed with a sparkle, each scanline of the new page appearsin a
random order. Each scanline replaces a piece of the old page.
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Chapter 18
Exiting the Power CG

WEell, all good things must cometo an end. Thisis also true of manuals and of programs.
Manuals just sort of fade into the back cover. But programs need to be exited.

When it’ stime to exit the Power CG, sealect the “ Exit” command from the “File” menu.

The program will begin its shut down sequence. The program can also be exited by
holding down the <Alt> key while pressing <X>.

Any page changes or settings changes that are not saved, will be lost when you exit the
program.

If the page has been modified, and the “Automatically Save Pages® setting in the “User
Preferences’ dialog box requiresit, the following message will appear.

Automatically Save Pages |

Do you want o zave
the changes to the
curent page?

Mo |

[f you don't want the zpztem to keep
azking pou this question, uze the
"Uzer Preferencesz" command in the
"Setup” menu to chanage the
“futomatically Save Pages" zettings.

If you want to save the changes to the page, press the <Y es> button , otherwise press the
<No> button and the changes will be discarded.

Just before the program exits, it will display the following message box.

Power CG |

@ Do you want ta zave the current zettings?

Hao | Cancel |

This message box gives you the option of saving the current project settings before you
exit.
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The current project setttings include the following:

Character, Edge, and Shadow attributes.

Style Gallery

Color Palette Settings.

Color Gradients

Loaded Typefaces

L oaded Textures

Typing mode

Lower Third mode

Default Directories

Any changes that you made to the Safetitle Margins, and Tab Settings.

Press <Y es> to save the project settings and exit the program. If you save the settings
they will be restored the next time you open the project. Press <No> to exit the program
without saving the settings. If you selected Exit accidentally, or you change your mind,
press <Cancel> and the Exit command will be canceled.

We hope you have enjoyed using the Power CG.
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